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Preface

The SINIX®/windows User Environment is an OSF/Motif-based user interface for SINIX
systems running SINIX V5.41 and above. It is a graphical interface with which you work
interactively.

It is an integrated, consistent working environment in which you can access graphics
applications on your screen using a mouse and the keyboard. The SINIX/windows User
Environment owes its consistency of appearance and behavior to the fact that it was
developed on the basis of OSF/Motif™, which itself builds on the network-transparent,
hardware-independent X Window System™.

Summary of contents

This manual, "SINIXwindows User Environment; Introduction to Handling and
Configuration”, is intended to provide users with a basic knowledge of the operation and
interactive configuration of the SINIX/windows User Environment graphical user interface. It
is therefore aimed at all those users who have no experience of interfaces based on
OSF/Motif or users who wish to get to know the SINIXwindows desktop. The manual falls
into two main parts:
The first part of the manual comprises the chapter "Input devices", the chapter "Logging
in and out" and the chapter "Controls". It provides you with a descrlption of the operating
strategies and standard controls for OSF/Motif that are also valid for the SINIX/windows
User Environment.
The second part of the book provides you with an introduction to working with the
desktop. The chapter "Help system, online manuals, manual pages" explains how to
request help on the desktop and look at the manual pages on the SINIX/windows User
Environment after you have successfully logged in. The chapter "The desktop" describes
the components and operating strategies of the desktop. The chapter "Using desktools"
provides you with an introduction to working with the applications that can be called from
the desktop. Interaction between desktools is demonstrated using a few examples from
your everyday working life. A brief description of the desktools is incorporated in this
introduction.
You will find a glossary, a list of references and an index at the back of the manual.
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1.2 Notational conventions

The following notational conventions have been used in this manual:

Example Meaning

Note Sections entitled Note alert you to important
points you should not ignore.

"Window References to other sections of this manual
s" and cross-references to other manuals are
enclosed in double quotes.

'Editor’ If reference is made to a string that you see
on the screen, the string is enclosed in
single quotes.

SHOME Commands, files and directories, i.e. data
you must enter exactly as specified, are
displayed in fixed-width font (@ fontin
which each character takes up the same
amount of space).

remote_h Italics are used for variables that you are to
ost replace by a concrete value. You must, for
example, replace remote_host with the valid
name of a host in your network.

<BSelect Virtual names are used to refer to mouse

> buttons since the mouse buttons can be
implemented and configured differently from
mouse to mouse. The virtual names are
assigned to physical mouse buttons in the
section "Virtual mouse buttons".

<KHelp> Virtual names are used to refer to keys if the
keys can be implemented in different ways.
The virtual names are assigned to physical
keys in the section "Virtual keys".

[SHIFT] Keys on the keyboard are displayed as
symbols if the action invoked by the key can
be associated uniquely with that key. For
example, suzrT] represents the shift key.

[SHIFT] + Keys, or keys and mouse buttons, that you
<BSelect must press simultaneously are joined by a
> plus sign (+). For example, the string [suIFT]
+ <BSelect> indicates that you are to press
and hold down the shift key (suzrr; and
then press the mouse button <BSelect>.

Table 1: Notational Conventions in the manual
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1.3 Changes since the last version of the manual

The table below lists the functional changes made to clients between Version 2.2 and
Version 3.0 of the SINIX/windows User Environment. Changes of an editorial nature and
corrections of mistakes in the documentation are only listed if they are of particular

significance.
Topic Brief description of change
The desktop New desktools include the

‘Communication Manager' see
section "Transferring a file to the
communication manager" and the
‘Audio Player' see section "Creating
and editing an audio file".

Table 2: Changes to SINIX/windows User Environment between version 2.2 and 3.0
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2

2.1

Input devices

The SINIX/windows User Environment provides you with a convenient way of utilizing the
functionality of the operating system with the help of a graphical user interface. It also
provides you with additional tools and applications. It is an OSF/Motif-based user interface
with standardized controls with which you can communicate with the operating system. This
communication takes place by means of various input devices. You can operate the
SINIX/windows User Environment using the mouse as a graphical pointing device and you
can also use the keyboard.

You use graphical pointing devices to select elements of the graphical user interface, thus
activating the associated applications. This means that you can edit or print a file or work
with a file residing on a remote host without having to use operating system commands.
The mouse is a convenient way of accessing the functionality of the SINIX/windows User
Environment interface. You will find more on this subject in the section "Using the mouse".
The keyboard is normally used solely to enter text. It is, however, possible to address the
elements of the interface with the keyboard. You will find more on this subject in the section
"Using the keyboard".

Using the mouse

The mouse makes it easy for you to make inputs as it allows you to move a graphical
symbol, the pointer, freely around the screen. Using the pointer, you can point to any
component of the interface and initiate an action by pressing the mouse buttons.

A two- or three-button mouse can be used in the SINIX/windows User Environment. See the
table in the section "Virtual mouse buttons" for information on the button bindings. Normally
a three-button mouse is used with OSF/Motif-based user interfaces, as this makes the
interface easier to use.

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600 Page 6



SINIX/windows User Environment V3.0 Introduction to Handling and Configuration  April 1996

Figure 1: The three-button mouse

The mouse returns its position to the system as relative coordinates: moving the mouse
across the desk moves the pointer across the screen. If you lift the mouse up from your
desk, the position of the pointer remains unchanged. The pointer does not move until you
place the mouse on the desk again and move it.

211 The pointer

The pointer is a movable graphical symbol on the screen. As you move the mouse on your
desk, the pointer moves around the screen accordingly. Whenever you are asked to "point
to" something, you should move the pointer so that it is positioned on the control involved.
Controls are graphically delimited areas on the screen. You will find an introduction to the
standard controls provided for use in OSF/Motif-based user interfaces in the chapter
"Controls".

The pointer can assume different shapes, depending on its location or on the action initiated
by the user.

An arrow pointing upwards and to the left

\ indicates the area that will be affected by the
next user action, provided the controls the
pointer is pointing at are managed by the
window manager.

This pointer shape indicates that the pointer is
I in an area where text can be input.

This pointer shape indicates that the pointer is
X located on the root window. The root window
provides the backdrop for all other windows.
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This pointer shape indicates that a window is
I currently being resized. The arrow indicates
the direction in which the window is being
expanded or reduced.

The hourglass or wristwatch symbol indicates
}:{ ¢ | that the system itself is executing some action
and that no user input can be accepted. The
user must wait until the action is completed or
move the pointer to another window.

A cross with arrows pointing in four directions
- indicates that a window is being moved.

A guestion mark appears when an action is

? expected from the user. It is displayed, for
example, when you select the menu item
‘Context-Sensitive Help' from the 'Help' menu.

Table 3: Common pointer shapes

2.1.2 Mouse techniques

There are some basic techniques for using a mouse to manipulate desktop objects. These

are:

Point Moving the mouse and positioning the
pointer anywhere on the desktop, e.g. on
an icon or a menu item.

Press Pressing and holding down a mouse button.

Release [ Releasing a mouse button after having
pressed it.

Click Quickly pressing and releasing a mouse
button without moving the mouse.

Double- Clicking a mouse button twice in rapid

click succession.

Drag Pointing to an interface element, pressing
and holding down a mouse button, moving
the pointer to a different position on the
screen and releasing the mouse button.

Table 4: Basic mouse techniques

The verbs listed in the left-hand column are used in this manual to indicate that you are to
perform the action described in the right-hand column.

2.1.3 Virtual mouse buttons

In the table below, the physical mouse buttons are assigned function-related names
referred to as virtual mouse buttons. The binding of a virtual mouse button to a physical
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mouse button can be varied in the configuration, which means that the table does not
necessarily correspond to your mouse. It is, for example, possible to reconfigure the button
binding for a left-handed user. For this reason the virtual mouse button names are used
instead of the physical mouse button names in this manual.

If your button bindings do not initiate the actions described, ask your system administrator

for help.

Virtual Physical Physical Pressing
mouse mouse mouse this mouse
button button button button ...?
3-button 2-button
mouse mouse
<BSelect left-hand left-hand selects or
> button button activates an
or mouse or mouse object.
button 1 button 1
<BTogg| [CcTRL] + [cTRL] + switches
e> left-hand left-hand between
button button selected
or mouse or mouse and
button 1 button 1 deselected
state.
<BExten [SHIFT] + [SHIFT] + extends a
d> left-hand left-hand selected or
button or button or deselected
mouse mouse area.
button 1 button 1
<BTransf middle left-hand + drags an
er> button right-hand object.
or mouse button or
button 2 mouse
button 1 +
mouse
button 2
<BMenu right-hand right-hand opens a
> button button pop-up
or mouse or mouse menu.
button 3 button 2
<BCusto right-hand right-hand initiates an
m> button button action
or mouse or mouse which
button 3 button 2 depends on
the
application
involved.

Table 5: Mapping virtual to physical mouse buttons
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YYou can perform various actions using the mouse buttons described above.
The information provided is only a general indication of the function involved.
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2.2 Using the keyboard

Although the SINIX/windows User Environment graphical interface was designed to be
operated with a mouse, its windows and controls can also be accessed and activated via
the keyboard. The table in the section "Virtual keys" contains the assignments of the
physical keys to the function-related names used in this manual.

2.2.1 Selection and text cursor

In a window, the selection cursor indicates the object associated with the keyboard input
while the text cursor indicates the position at which text may be entered.

2.2.1.1 Selection cursor

As the keyboard cannot be used to position a pointer on the screen, keyboard operation is
based on the location of the selection cursor, which shows the user which object will be
affected by the next input. This object, e.g. a button or text box, is highlighted in some way.
It may, for example, have a rectangle around it, or appear in 3-D, or be in reverse video.

Question_popup

Which format do You like 7

#-Bitmap cancel write

Figure 2: Push.buttons with séiectlon cursor. )

2.2.1.2 Text cursor

In a text window, the insertion point (where text that you enter will be inserted) is indicated
by a text cursor. An I-beam text cursor is normally displayed in text boxes.

Desktop

Enter name of new folder for kerstini@gmZchat

ik Cancel

Figure 3: Text cursor in a text box
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2.2.3
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Navigating with the keyboard

You can operate the graphical interface with the keyboard by assigning the selection cursor
to a different window or a control in the same window and then activating the object.
Keyboard input can only be received by the active window. To activate a window, you can
change the stacking order of the windows with the keyboard (see section "Window stack™).
You can use the keyboard to move the selection cursor to other controls in the active
window. Pressing the keys <KUp>, <KDown>, <KRight> and <KLeft> allow you to navigate
to other controls within a window area, for example, to different pushbuttons.

If a window is made up of several areas, you can move between these areas in a
predefined order using the <KNextField> and <KPrevField> keys. You could, for example,
activate the text area, the scroll bar and the pushbuttons in the help window, one after the
other.

Pressing the <KMenuBar> key selects the menu bar of a window. You can activate the
individual menu items by means of mnemonics and accelerators (see section "Menu
items").

An action is invoked for the selected control by pressing the <KActivate> key.

Virtual keys

In the table below, the physical keys are assigned function-related names, referred to as
virtual keys. The binding of virtual keys to physical keys can be varied in the

configuration.

The table only includes the virtual keys needed for moving between controls. You can
obtain an overview of the key bindings by requesting help information on the keyboard and
mouse via a window's 'Help' menu (see section "The 'Help' menu").

If your key bindings do not correspond to the functions described, ask your system
administrator for help.

Virtual key Physical key Pressing the
key ...V
<KSelect> [SPACE] Of selects an object.
[CTRL] + [SPACE]
<KActivate> [ENTER] Of activates an
[CTRL] + [ENTER] object.
<KLeft>, [LEFT], [RIGHT] , moves the
<KRight>, tup] and [pown] selection cursor
<KUp> and within a window
<KDown> area.
<KNextField> [TaB RIGcHT] and moves the
and [TAB LEFT] selection cursor
<KPrevField> between different
window areas.
<KMenuBar> [F10] activates and
deactivates the
menu bar of a

Ident.: 08902-J-2145-6-7600
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window.

<KMenu> [MENU] OF [F4] opens a pop-up
menu associated
with interface
components.
<KHelp> [HELP] OF [F1] calls
context-sensitive
help for the
selected object.

Table 6: Mapping virtual to physical keys

YUsing the keys described you can perform a number of different actions. The information
provided is only a general indication of the function involved.
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3 Logging in and out

If SINIX/windows User Environment is installed on your system, a login window will be

displayed in which you can log in to the system.

The login window consists of

- an area in which the login names on the host are displayed as icons. If not all the icons
can be displayed, a scroll bar is provided with which you can scroll the area (see section
"Boxes");

- awelcome text which includes the name of the host;

- the text boxes 'Login:' and 'Password:' in which you enter your login name and password;

- the option buttons 'Session:' and 'Language:' by which you choose a session and a
language;

- the pushbuttons 'OK’, 'RestartSession’ and ‘Help'.

The appearance of this window, for example the labels of the text entry boxes and option

buttons, can be modified by the system administrator. The icon area and the option buttons

are optional. You will, however, always see the login and password text boxes and the

pushbuttons at the bottom of the window.
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SIEMENS
NIXDORF

Welcome to SINIX/windows (aspen)

@ ]

——T 5|

¥

Login:

Password:
Session: | User Session 1= Language: |English =
|DK |Restart |Help

Figure 4: The login window

Note:

If you do not see the login window on your screen this may be because
a screen saver has been activated. If this is the case, you will see one of the following
depending on what defaults have been set:
- the X logo appears against a backdrop and changes its color, size and position at
regular intervals.
- it looks like the screen has not been switched on.
In both cases you only have to move the mouse in order to see the login window.
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3.1

After a predefined interval the screen saver again goes into effect in order to conserve
the picture tube.

your system administrator has configured the SINIX/windows User Environment in
such a way that you must first select the host you wish to log in to. In this case, the
host selection window is displayed in which the hosts are displayed as icons. This can
be useful, for example, if you are working at an X terminal. Ask your system
administrator on which of the displayed hosts the SINIX/windows User Environment is
installed.

Click on the 'Help' pushbutton in the host selection window with the mouse button
<BSelect> to obtain help on using the window.

After you have selected a host, the login window of this host is displayed. You can
return to the host selection window by pressing crru1+c1 in the login window.

Logging in

Before you can log in to the system, the system administrator must set up a user account

for you. You must know your login name and the corresponding password.

There are various ways of logging in, depending on the appearance of the login window.

Click on the 'Help' pushbutton with the mouse button <BSelect> to obtain help on logging in.

You can always log in by doing the following:

1. Click on the 'Login:' text box with the mouse button <BSelect>. The edge of the box is
highlighted. The 'Login:' text box is now assigned the input focus, i.e. it is ready to accept
keyboard input.

2. Enter your login name at the keyboard. If you have made a typing error, you can correct
your input character by character using the (sackseace] key.

3. Press [enterR] tO cOnfirm your input. The 'Password:' text box is subsequently assigned
the input focus.

4. Enter your password at the keyboard. Although the characters you enter are not echoed
on the screen you can still correct your input using the reackseacel key.

5. Press (enter] to confirm your input.

If your input was not correct, an error message is issued and you must start again at point

1.

If your input is accepted, the login window disappears and is replaced shortly after by the

graphical user interface.

Note:
- If your password has expired, you are requested to change it. You have to enter your
old password and then a new password. To confirm your new password you have to
enter it again.
If a screen saver has been activated and you press a key, the screen contents are
displayed but pressing the key is interpreted as your first input. You are only allowed
a certain number of login attempts. This number depends on the level of operating
system security. Thus it is best to move the mouse in order to display the screen
contents.

Your session is started when you log in and is terminated when you log out.
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3.11 Language of the interface

This manual describes the English interface. You can set the interface language before
login by clicking on the 'Language’ option button in the login window with the <BSelect>
mouse button. Then select a language from the pop-up menu that subsequently appears.
Now log in as described above (steps 1 through 5).

However, you can also change the interface language during a session. You can use the
'International’ desktool for this purpose. The new language will take effect the next time you
log in.

3.1.2 Sessions

From the option menu "Session" in the login window you can choose from different kinds of

sessions:

Menu Action

option

User starts the user-defined session defined in

Session the
$HOME/ .xsession file, if it exists; otherwise
the "Default Session".

Default starts the CDE Desktop if it is installed,

Session otherwise the SINIX/windows Desktop.

SINIX starts the SINIX/windows Desktop. This

Desktop option appears only if the SINIX/windows
Desktop and also the CDE Desktop are
installed.

Light starts a session without desktop.

Session

Failsafe starts only a terminal emulator.

Session

Table 7: Sessions

The CDE Desktop ("Default Session") or the "SINIX/Desktop” are only started if the option
"Start desktop on login" has been defined for the selected login by the User Manager.
Otherwise a "Light Session" is started.
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3.2 Interrupting a session

You do not necessarily have to terminate your session if you wish to leave your desk for a
while and want to prevent unauthorized users from accessing your screen. You can use the
'‘Lock Screen' desktool to interrupt your session. You release the screen by entering your
password. The screen is then unlocked, and the graphical user interface is redisplayed
exactly as it was when you interrupted your session.

3.21 Locking screen and activating the screen saver

It is assumed that the desktop is still in its original configuration. To lock the screen, you do

the following:

1. Open the 'System' toolbox on your desktop by double-clicking on the icon with the
mouse button <BSelect>.

2. Start the 'Lock Screen/Screen Saver' desktool by double-clicking on the appropriate icon
with the mouse button <BSelect>.

A screen saver is activated.

3.2.2 Unlocking the screen

To unlock the screen, you do the following:

1. Press any key or mouse button or simply move the mouse. This deactivates the screen
saver and you are requested to enter your password.

2. Enter your password from the keyboard.
If a valid password is not entered in a certain time (e.g. 30 seconds), the screen saver is
activated again.

3. Press (enter] to confirm your input. The ‘Lock Screen/Screen Saver' desktool is
terminated and the graphical user interface is again displayed.

If your input is not correct, an error message is issued and you must start again with point

2.
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3.3 Logging out

When you terminate the SINIX/windows User Environment, you automatically log out of the
system. Before you do this you should make sure that you have terminated all active
applications properly so that no data is lost.

The logout procedure depends on how your desktop is configured. There are two options:
the desktool icons are located either in the background (root window) or in desktop
windows. These windows can be the window named 'Main Desktop' and/or the window
named 'Tool Catalog' (see "The desktop").

3.3.1 The desktop as awindow

If the desktop is displayed as a window, you do the following:
1. Point to the 'File' menu.

Il File Edit view oOptions Help

el = [l (XTI 21

igure 5: Menu bar of the 'Main Desktop' window

1. Press and hold down the mouse button <BSelect>. A pull-down menu is displayed.
2. Drag the pointer to the 'Exit' command and then release the mouse button.
The procedure is the same for the window entitled "Tool Catalog'.

3.3.2 The desktop in the root window

If the desktop manager is visible as an icon in the root window, you do the following:
1. Point to the 'Desktop Manager" icon.
2. Press and hold down the mouse button <BMenu>. A pop-up menu is displayed.

Desktop
Manager

Figure 6: The 'Desktop Manager" icon

1. Drag the pointer to the 'Exit' command and then release the mouse button.
In both cases a window is displayed in which you are asked if you really wish to terminate
the desktop.
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| Terminate the Desktop

Do you want to terminate the Deskiop®?

Mo Help

Figure 7: The "Terminate Desktop' message box

1. Point to the 'Yes' pushbutton and click <BSelect>.

Depending on the configuration of the desktop, you may also be asked whether you wish to
save the current desktop configuration. If you save the current configuration, the desktop
will appear exactly as you leave it the next time you log in.

All windows are now closed and after a brief interval the SINIX/windows User Environment
login window is again displayed. You or another user may now log in.
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4.1

Controls

In standardized user interfaces such as the SINIX/windows User Environment, controls
provided by the interface are all operated in the same way. These controls are consistent in
their appearance and behave in a consistent manner. In the following you will be introduced
to the standard interface elements and how they are operated.

First of all, you will be made familiar with the term "window" (see section "Windows").
Windowing makes it possible to display the interfaces of several applications on the screen
simultaneously and also allows you to work on several hosts at the same time.

If you have several windows open at the same time, the screen may become rather
cluttered. It is therefore possible to move windows, reduce the size of windows and move a
window that is totally or partially obscured by another window to the forefront. These
functions are provided by a separate application, the window manager. The window
manager provides each window with a frame. It is this typical window frame which
characterizes OSF/Motif-based user interfaces. You use this frame to manipulate each
window in the same manner. For more information please refer to the section "Window
management".

Each window can be fitted with a number of controls, such as menus containing menu
items, buttons, scales, text boxes, etc. You will find a systematic introduction to these
controls in the sections "Controls in windows" and "Menus".

Windows

A window is a graphically delimited area on the screen whose borders are parallel with the
edges of the screen. It serves as an input/output area for the application that generated the
window. Applications that can open a window on the screen are referred to as clients. For
more information on the term "client" please refer to "SINIX/windows User Environment;
Guide for Experts and System Administrators".

Any number of windows may be opened at any one time. The windows may be positioned
side by side or they may overlap.
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sample_window 1 All  fArea Graphic Hotspot

Bbackground: white
#foreground: black
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Figure 8: Windows on a screen

Windows are assigned one color for the background and one or more colors for the
foreground, i.e. for texts that appear on the background. A window has a border that is
colored differently to the window's background. The window border is not visible if a window
manager is active. In this case it is hidden by the window frame.

The appearance of a window and the elements in a window are defined by the client which
owns the window.

4.1.1 The different types of window

There are several types of window:
- the root window

- primary and secondary windows
- message windows

41.1.1 Theroot window
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41.1.2

41.1.3

41.2

41.2.1

The root window provides the backdrop for all other windows and covers the entire screen.
It does not have a window frame. All other windows appear stakked on the root window.
The root window is displayed in a color and a pattern which together form the screen
background.

Primary and secondary windows

Generally when you call a client, one or more windows are generated. These windows,
referred to in the following as primary windows, allow you to supply mouse or keyboard
input that is processed by the associated client.

Additional windows for performing special tasks can be opened via a primary window.
These windows are called secondary windows. Secondary windows can usually be closed
individually by means of pushbuttons. If you close a primary window, all secondary windows
associated with that client are also closed.

Message windows

Message windows are a special type of secondary window that contain a dialog box and
messages from the program to the user. Message windows are also known as message
boxes.

Modal windows are a special kind of message box. These boxes prompt the user to make
an input. You cannot continue working in any primary or secondary window owned by the
associated application (application modal) or you can no longer make any input in any other
window (system modal) until you have made an input.

There are also message boxes that merely provide the user with information on a certain
action being performed by the program. These boxes are closed automatically.

There are several types of message box, each containing a different type of message.
There are

- error boxes

- warning boxes

- information boxes

- question boxes

- working boxes

Each box is displayed with its own special symbol, making it easier to identify the type of
message being displayed.

Input

Only an active window can receive input from the keyboard. Only one window can be active
at any one time. The active window is identified by the background color of the window
frame: the background color is different to all other windows.

You make a window active by clicking on it with the mouse button <BSelect>. It is also
possible to specify that a window is to be activated when the pointer is positioned on the
window. This behavior can be set with the 'Window Manager' desktool.

Input focus

The position of the input focus is indicated by highlighting of the active window, identifying
the object which the next user action will affect.
The control with the input focus has a highlighted border. This is referred to as the selection
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cursor. You can use the keyboard to move the selection cursor, and hence the input focus,
around in the window (see section "Navigating with the keyboard"). Selecting an object
without activating it is useful if you wish to obtain context-sensitive help information on that
object.

4.1.3 Output

Several clients can output information simultaneously in their respective windows. A client
can continue to output in its window, even if it is partially or completely obscured by another
window, has been minimized (see the section "Window manager icons") or another window
is receiving user input.
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4.2

42.1

4211

42.1.2

Window management

The Motif Window Manager (mwm), from now on referred to simply as the window manager,
is a central component of OSF/Motif-based user interfaces such as the SINIX/windows User
Environment. The window manager provides you with functions that allow you to manipulate
windows, e.g. resize, reposition or minimize a window or activate a window by assigning it
the input focus. The window manager also provides functions for terminating applications.
By default, the window manager is started at the beginning of a session and manages all
client windows.

Window frame

The window manager surrounds each primary and secondary window with a window frame.
Window frames are equipped with a number of different controls, each associated with a
specific function. All the controls that a window frame can feature are described briefly
below.

window menu button title area minimize button
\k / maximize
title bar | - samp le_Window 2 |3H——  button

matte

resize border

Figure 9: The window manager window frame

Title bar

The title bar consists of the window menu button, the title area, the minimize button and the
maximize button. These controls are arranged from left to right on the title bar.

Title area
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The title area contains the window title, which may include the client's name. In addition,
you can use the title area to move the window:

Position the pointer anywhere in the title area, press <BSelect> and drag the window to a
new position. A wire frame outline represents the location of the frame during the move
operation. As soon as you release the mouse button, the window is moved to the new
location.

sample_window

¢ 160161 3

Figure 10: Moving a window

4.2.1.3 Minimize button

The minimize button is the second button from the right in the title bar (the box with a small
square in it). When you click on the minimize button with <BSelect>, the window is
minimized, i.e. changed to an icon.

4.2.1.4 Maximize button
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The maximize button is the button on the far right of the title bar (the box with the large
square in it). When you click on the maximize button with <BSelect>, the window is
enlarged so that it fills the screen (or to the maximum size allowed by the configuration
files). When you click on the maximize button of a window that has already been
"maximized" with <BSelect>, the window is returned to its previous size.

Window menu button

The window menu button is the horizontal bar in the box to the left of the title area. You

select an item from the window menu by doing the following:

- Position the pointer on the window menu button, click <BSelect> and then click on the
desired menu item. You may also position the pointer on the window menu button and
press and hold down <BSelect>; then drag the pointer to the menu item you want to

select and release the mouse button.

- Position the pointer on the window frame. Press the mouse button <BMenu>. Drag the
pointer to the menu item you want to select, then release the mouse button.

Menu Acceler Function

item ator

Restore [aLT] + Restore normal window size.
[F5]

Move [ALT] + Change location of window.
[F7]

Size [aLT] + Change size of window.
[F8]

Minimize [aLT] + Change window to icon.
[F9]

Maximize | (avt) + Enlarge to maximum size.
[F10]

Lower [aLT] + Send window to bottom of
[F3] window stack.

Close [aLT] + Close window and terminate
[F4] client.

Table 8: Items in the window menu

Double-clicking <BSelect> on the window menu button closes the window. This has the
same effect as selecting ‘Close’ from the window menu.

Resize borders

You can use the resize border to change the size of a window.

The resize border surrounds the entire window and consists of a number of resize handles.
The corners of the window can be used to resize a window vertically and horizontally at the
same time. For example, using the upper right corner, you can resize a window upwards
and to the right. The resize handles on the four sides of the window allow you to resize a
window in the corresponding direction, e.g. the resize handle on the right allows you to
resize a window from the right.
If a window does not have a resize border, the size of the window cannot be changed.
To resize a window, position the pointer on a resize handle (the pointer changes shape).
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4217

42.2

Press <BSelect> and resize the window by dragging the pointer across the screen until it is
the size you want. While you drag the pointer, a rubber-band outline is displayed to indicate
the size the window will become when you release the mouse button.

sample_window

10040

Figure 11: Resizing a window

Matte

The matte is an optional area that can be added between the client area and the mwm
window frame. You can use the window manager to insert the matte and to influence its
appearance using the appropriate resources. There is no functionality associated with the
matte.

Window stack

The window stack is a result of the position of the windows on the screen; the order of the
windows in the window stack is referred to as the stacking order. A window is on the top of
the stack if it is not obscured by any other window, a window is on the bottom of the stack if
it does not obscure any other window.
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Figure 12: The window stack

Changing the stacking order with the mouse

The window stacking order can be changed

- with the menu items 'Shuffle Up' and 'Shuffle Down' on the root menu (see section "The
root menu"),

- with the menu item 'Lower' on the window menu,

- as the result of a window receiving or losing the input focus.

When a window is minimized, its icon is usually placed at the bottom of the stack or in the

icon box. The window at the top of the stack is assigned the input focus.

Changing stacking order with the keyboard
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The accelerators for changing the stacking order differ depending on the value assigned to
the keyboardFocusPolicy Window manager resource. You can modify this resource with the

'‘Window Manager' desktool.

activated explicitly by
clicking on it with
<BSelect>.

Accelerator Requirements Function
description

[ALT] + [TAB The accelerators are The next window in

RIGHT] valid if a window is the stack is

assigned the input
focus.

[ALT] + [SHIFT] +
[TAB RIGHT]

as above

The bottom window
in the stack is
assigned the input
focus.

[ALT] + [ESC]

The accelerators are
valid if a window
becomes active as
soon as the pointer is

The top window is
lowered to the
bottom of the stack
(cf. 'Shuffle Down'

4.2.3

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600

moved on to the
window.

on root menu).

[ALT] + [SHIFT] + as above The bottom window
[ESC] is raised to the top
of the stack (cf.
'‘Shuffle Up' on root

menu).

Table 9: Changing window stacking order with the keyboard

Window manager icons

Icons are small graphical images used to represent objects that you can use to access a
variety of functions. Icons consist of an icon image and an icon label. All icons have a
predefined size.

One special icon type comprises the icons managed by the window manager. These are
icons representing the windows of active applications. Another type of icon is described in
the chapter "The desktop”: the icons made available by object managers such as the
desktop manager.

If you are working with a number of windows simultaneously, you can minimize windows
that you do not currently need and thus reduce the clutter on your screen. Clients whose
windows have been minimized have not been terminated. You can change a window into an
icon by clicking on the minimize button in the title bar with the mouse button <BSelect> or
by selecting 'Minimize' from the window menu.
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4231

42.3.2

icon image

icon label

Figure 13: Anicon

Icons are either arranged in a row in the root window, or placed in an icon box, depending
on your configuration. The icon box contains not just windows that have been minimized but
also normal open windows, which are displayed two-dimensionally.

Double-clicking the mouse button <BSelect> on an icon changes it back to its normal size. If
the icon represents an open window, the window is placed on the top of the stack.

You can drag an icon around the user interface using either of the mouse buttons
<BSelect> or <BTransfer>.

The icon menu

An icon has no window frame and thus no window menu button. You display the icon menu
by clicking <BSelect> on the relevant icon. The items on the icon menu are the same as
those on the window menu.

The icon box

The icon box is an mwm window. The window manager uses the icon box to store the icons
of all windows opened during a session by starting a client. Windows that have been
minimized are displayed in the icon box three-dimensionally, open windows
two-dimensionally.
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The window manager only creates an icon box if it was configured correspondingly when it
was started. You can change the configuration using the 'Window Manager' desktool; any
changes made do not take effect until the next time the window manager is started.

The icon box, like all windows, also has a window menu. This is the same as the standard
window menu with the exception of the menu item 'Pack Icons', which replaces the menu
item 'Close’. When you select 'Pack Icons', the icons are arranged side by side in the icon
box.

42.4 The root menu

The root menu is a pop-up menu (see section "Pop-up menu") associated with the root
window and is generated by the window manager. It contains items which you can use to
call window manager functions and start other applications.

Root Menu

xterm
*97801-480 [=
xpet b EIFnt:-nts
Shuffle Up
Shuffle Down
Refresh
Pack lcons

Restart...
Figure 15: Root menu

F13
F16
F24

To display the root menu, press the mouse button <BSelect> somewhere on the root
window outside the client windows. Drag the pointer to the item you want to select and then
release the mouse button. The menu then disappears and the selected action is performed.
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Menu Function

item

xterm Starts the xterm terminal emulator.

x97801-4 | Starts the x97s801-480 terminal emulator.

80 Different fonts can be set using items in a
cascade menu.

xpct Starts the xpct terminal emulator. Different
fonts can be set using items in a cascade
menu.

Shuffle Raises the bottom window to the top of the

Up stack.

Shuffle Moves the top window to the bottom of the

Down stack.

Refresh Redraws the screen.

Pack Arranges the window manager icons side by

icons side

Restart Restarts the mwm window manager.

Table 10: Items in root menu
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4.3

43.1

4311

43.1.2

4.3.1.3

Controls in windows

OSF/Motif-based user interfaces provide a number of standardized controls that make it
easier for the user to select and execute functions. All controls with the same appearance
are operated identically and all behave in a consistent manner.

All controls belong to one of the following groups:

- buttons

- boxes

- groups boxes

Within a window, various controls can be grouped together creating window areas. In paned
windows, these areas can be resized, i.e. one area can be enlarged while the surrounding
areas are reduced in size.

Only the controls relevant to the SINIX/windows User Environment are described.

Buttons

Buttons are delimited areas in windows that are surrounded by a 3-D shadow. They may
have a label consisting of text or a graphic image.

You activate a button by clicking on it with the mouse button <BSelect>. The action that is
invoked depends on the type of button.

Pushbutton

A button that is used to invoke an action. It has a label (text or bitmap) describing the
action.

Edit

Figure 16: Different pushbuttons

Toggle button

A button that is used to switch between two states: set or not set. A toggle button provides a
visual indication of its state. A toggle button that has been set looks like it has been pushed
in. A toggle button can be either a check button or a radio button.

Check button

A check button is one of a set of toggle buttons, any number of which may be set at the
same time.
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O Show font resources
showr color resources

O Show true/false resources

O Show file resources

Show translation resources

O Show other resources
Figure 17: Check buttons

4.3.1.4 Radio button

A radio button is one of a set of mutually exclusive toggle buttons, i.e. only one radio button
may be set at any one time.

Font Selection

[talics Weight Farnily Point Size

O Don'tcare < Don'tcare  <» Don't care <> Don’t care

4 Normal <> Normal <> Times <> 10 point
<> Oblique # Bold # Helvetica £ 12 point
&> Ttalic > Demi &> Avant Garde  <r 13 point
< %:EETSE <> Book <» Courier 4 14 point

97801480 <> 16 point
&> Fized <> 18 point
£ 24 point

Figure 18: Radio buttons

4.3.1.5 Option button

A button that can be used to display an options menu. The button label indicates the current
option. In order to distinguish an option button from other buttons, the option button includes
a horizontal bar in addition to the label.
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4.3.2

4321

4.3.2.2

Alpha-Editar Wi |
Figure 19: Option button

Boxes

Boxes are areas within a window used to display, input or edit texts, graphics, colors, etc.
The following is a description of the different types of box.

Scale

A box containing a slider used to set a scalable value within a specified value range. The
position of the slider indicates the position of the value within the range. The value is
displayed as a number.

Set Poll Rate

Set the poll rate (in seconds)
10

[T

Ok Cancel

Figure 20: Scale

You change the value by moving the slider to a new position using the mouse button
<BSelect>.

Scroll bar

A box consisting of the bar itself, a slider and two arrow buttons. It is coupled with a window
area in which part of the whole area is displayed. The bar represents the complete area that
the user can display. The length and position of the slider indicates the currently visible
section of the area. There are vertical and horizontal scroll bars.
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aArrow slider

button
visible part non-visible part
of area of area

Figure 21: Scroll bar

To display a different section, drag the slider to a different position on the bar using the
mouse button <BSelect>. You can also click on the arrow buttons to move the visible

section in the corresponding direction.
4.3.2.3 List box

A box in which entries are displayed in list form. One or more items can be selected by
clicking on them with <BSelect> in order to modify them, for example.

Help hooks

Helo_ L _f
Host hManager

tdail hManager iy

Figure 22: List box

4.3.2.4 Text box

A box in which text can be displayed, entered or edited. You activate a text box by clicking
on it with the mouse button <BSelect>.

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600 Page 37



SINIX/windows User Environment V3.0 Introduction to Handling and Configuration  April 1996

4.3.3

433.1

4.3.3.2

Move to Named Folder

Enter the name of the destination folder

fhume!kerstinfBilderEﬂ

Figure 23: Text box

Group boxes

Controls can be grouped together, for example:

Menu A menu groups together a number of buttons
and arranges them in a menu.
Bar A bar groups together a number of similar

controls and arranges them in a row (e.qg.
menu bar, button bar).

Dialog A dialog box groups together a number of

box different controls that prompt the user to make
an input. A text box, list box or a button bar
can, for example, be provided for user input.

Icon bar

An icon bar appears at the top of the SINIX/windows object manager window, beneath the
menu bar. The icon bar is not displayed if you specified No for the option 'Display icon bar
yes/no' in the 'Options' pull-down menu.

BE BEE On X |\|

F'igure 24: The icon bar

The icon bar displays buttons which you can use to select options or call the functions that
you use the most. Within the icon bar, the individual buttons are grouped by functions, such
as the display mode, operations on objects and help functions. When you position the
pointer on a specific button, the status line shows you which function this button invokes.
There are also other ways to access these functions and options (e.g. menus, keyboard:
see the appropriate sections). However, it is often faster and easier to use the buttons.

Status line

A status line appears at the bottom of the SINIX/windows object manager. The status line is
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4.3.4

not displayed if you specified No for the option 'Display status line yes/no' in the 'Options’
pull-down menu.

The status line shows you which objects are available or selected and which functions are
associated with buttons or menus. The display is linked to the pointer, which means that it
changes continuously as you move the pointer across the screen, thereby passing over
various elements.

You cannot write on the status line directly.

|
T1E ohject{s], 1 selected IT
Figuré 25: Status line

Paned window

A paned window comprises a number of window panes that are separated from each other
by separators. The separators can be used to divide the window into panes vertically and
horizontally. The sash on the window enables you to change the size of a pane. When you
enlarge/reduce a pane, the surrounding panes are reduced/enlarged proportionately.

— samp le_Window = |
[y
window area
W
seperator . sash

[=

window area
T,

Figure 26: Paned window

A window pane can be enlarged or reduced in size by dragging the handle on the separator
to a new position with the mouse button <BSelect>.
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4.4

44.1

4411

44.1.2

Menus

Menus provide you with an easy way of invoking actions. A menu is a list of actions. Each
action on the list has a name, the menu item, consisting of a character string or a graphic
image (bitmap). The list itself also has a name, the menu title.

Each menu item can be assigned a predefined key or button sequence. You invoke an
action by selecting the appropriate menu item from the menu.

Types of menu

There are several types of menu: pull-down menus, pop-up menus, cascade menus and
options menus.

Pull-down menu

Pull-down menus are accessed in a window by means of a label and can be arranged in a
row in the menu bar at the top of the window. The label of a pull-down menu can be either a
name or a graphical symbol (e.g. window menu button).

¥97801 | Mode Dizplay HKevboard

Logging

Interrupt program
Hangup program
Terminate program

Kill program

Unmap menu

Juit
Figure 27: A pull-down menu

You open a pull-down menu by pointing to the label and pressing and holding down the
mouse button <BSelect>. Drag the pointer to the desired menu item and release the mouse
button. The selected action is executed.

You can also click on the label with <BSelect>. You can them click on the desired menu
item on the menu that is displayed.

Pop-up menu

These menus take up no permanent space in the window, but are associated with a
particular client work area. For example, the window manager provides a pop-up menu, the
root menu, in the root window.
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Root Menu

xterm
*97801-480 [=
xpct [
Shuffle Up
Shuffle Down
Refresh

Pack lcons

Restart...
Figure 28: A pop-up menu

A pop-up menu "pops up" at the current pointer location when you press and hold down the
mouse button <BMenu>. You then drag the pointer to the desired menu item and release
the mouse button.

44.1.3 Cascade menu

Both pull-down and pop-up menus can have submenus, known as cascade menus. The
items in a cascade menu amplify the corresponding item on the parent menu. An arrow to
the right of a menu item indicates that there is a cascade menu for that item.

Root Menu

xterm
*97801-480 [=
xpet b EIFnt:-nts
Shuffle Up
Shuffle Down
Refresh
Pack lcons

Restart...
Figure 29: A cascade menu

F13
F16
F24

You open a cascade menu by dragging the pointer onto the appropriate menu item.

44.1.4 Options menu

An options menu can be accessed on the user interface via the associated options button.
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44.2

4421

4422

4423

You open an options menu by positioning the pointer on the options button and clicking or
pressing and holding down the mouse button <BSelect>. Once you have selected a menu
item, the menu is closed and the selected item is used as the label for the options button.

Alpha-Editor | ¢ vi =
ced

meazed

Figure 30: An options menu

Menu items

The individual entries in a menu are known as menu items. An action is invoked by
selecting a menu item. A menu item that cannot be activated in the current context is grayed
out. In addition to the menu names that indicate the associated action, the menu item can
also provide information about what type of action will be performed or how to initiate the
action from the keyboard.

Cascade menu items

An arrow to the right of an item indicates a cascade menu item. If this menu item is
activated, the associated cascade menu is automatically opened next to the menu item.
This menu may also include cascade menu items.

Dialog menu items

Dialog menu items end with an ellipsis. If you select one of these items, additional
information is requested in a dialog box.

{Eile Edit Yiew Options Help
Save

Restart...

Exit...
Figure 31: Dialog menu items

Selection menu items

Selection menu items are indicated by a toggle button to the left of the item that indicates
the current status. Items currently selected are displayed in 3-D to look like they have been
pushed in.
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4.4.2.5

View|Options
o Reorganize icons
View as b>| 4 Standard icons
<> Alternate icons
<> Label only

Figure 32: Radio buttons

View | Options

sort By Value -
sort By Specification -
sort By Resource -

O Show font resources

showr color resources
O Show true/false resources
O Show file resources

show translation resources

O Show other resources
Figure 33: Check buttons

Mnemonics

A mnemonic is a letter of the alphabet that uniquely identifies an item within the menu. You
use a mnemonic to quickly make a selection from an open (visible) menu by pressing a
single letter on the keyboard. If a mnemonic has been defined, the corresponding letter of
the item is underlined on the menu. Mnemonics are not case-sensitive.

A mnemonic is normally the first letter of the relevant menu item as this is the easiest to
remember. If two menu items start with the same letter, a different, characteristic letter will
be used as the mnemonic for the second menu item.

Accelerators

You can use a predefined key sequence (accelerator) assigned to a menu item to quickly
make a selection from a menu without having to display the menu. Refer to the relevant
menu items to see which accelerators have been defined.

The accelerator for a menu item must be unique within the context in which the menu could
be displayed.
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443 Standard menus

In order to ensure a uniform appearance of the user interface, the menu bar has the same
structure for all OSF/Motif-based interfaces.

The menus described below are the standard menus. Menus may be omitted if an
application does not supply the associated functionality. An application may also create
additional menus specific to the nature of the application. If, however, an application uses
the following menus, the layout and meaning of the items on them always remain the same.

File This menu contains items for performing
actions on files, such as opening, closing or
printing.

It may also contain menu items that affect the
application itself, e.g. 'Exit' for terminating the
relevant application properly.

Edit This menu contains items for performing
actions on the data output by the client to the
window, such as cutting, copying, pasting or
deleting. This menu may also contain an undo
function for reversing the action.

View This menu contains items controlling how data
is displayed, e.g. by displaying data according
to defined criteria, or by sorting the data in a
specific order.

Option This menu contains items that enable the user
S to control the client, e.g. commands.

Help This menu contains items that provide the
user with help information. The help menu is
alway located on the far right of the menu bar.

Table 12: Standard menus in the menu bar
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5 Help system, online manuals, manual pages

In addition to this manual and its three companions, other sources of information on the
operation and functionality of the SINIX/windows User Environment are available. The help
system, online manuals and manual pages are available online while you are working.
When using them, powerful search and navigation tools give you the fastest possible
access to the desired information. In just a short time, you will see how advantageous these
tools can be when working with the SINIX/windows User Environment.

The section entitled "The help system” provides you with an explanation of the various
ways of obtaining help. This section also tells you how to request help on the help system
itself, and how you can determine which desktools on the desktop are part of the
SINIX/windows User Environment.

If your system administrator has installed the online manuals of the SINIX/windows User
Environment, you will have this and the other three manuals available as files on CD-ROM.
These online manuals are identical to the printed manuals with regard to the contents. To
find out how to use these manuals for your work, refer to section "The 'Infothek’ desktool".
You can also display the client descriptions in the SINIX/windows User Environment in the
form of manual pages, provided that your system administrator has installed them. This tool,
which supplies information in English and is not integrated into the OSF/Motif user interface,
is described in section "Displaying manual pages".

51 The help system

The help system is available as soon as you log in. Before calling up a desktool, activating a
menu item or using a component of the graphical user interface, you can find out whether
the action you are about to take does indeed produce the result you are looking for.

5.11 Requesting help

There are five different ways to access the help system:

- You can access the general functions of the help system by opening the 'Help
pull-down menu on the right-hand side of the menu bar at the top of the window "The
'Help' menu".

You can obtain help on selected objects, windows, menu items, etc. by pressing the
<KHelp> ( #err] or [r11) key "Requesting context-sensitive help with the <KHelp> key".
You can obtain action-oriented information on individual objects in the object managers
by opening the pop-up menus for these objects "Help in an icon pop-up menu".

You can gain a task-oriented overview of the current window by selecting the 'Help'
button on the window icon bar "Requesting context-sensitive help with the <KHelp>
key".

Windows without menu bars have a 'Help' pushbutton which you can use to obtain
information about the current window "The 'Help' pushbutton in windows without a menu
bar".

Several desktools ('Lock Screen’, ‘Clock’, 'Calculator’, 'Manuals') do not support the help

system described here. You can, however, display an overview of the desktools as a help

text before you call one of these desktools. You display this overview as described in the
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section "Help in an icon pop-up menu".

Please note that the available help texts generally relate to the window or object from which
they are called. Although you can navigate freely through the help system, you will obtain
the information more quickly if you access the help system directly from the object for which
you need help.

Please note that not all the methods of obtaining help described below can be used in every
situation. For example, the way in which you obtain help on the current window depends on
whether the window provides a 'Help' pushbutton or a 'Help' menu. On the other hand, there
are several ways of obtaining the same information. You can, for example, request
information on the mouse buttons and the keyboard in every window by means of the help
menu.

Context-sensitive help

In the SINIX/windows User Environment, context-sensitive help refers to help on a
component of the graphical user interface such as help on a window control or on an icon in
an object manager. As a result, you always call context-sensitive help in two phases: you
first determine the context in which you need help. Then you call the help function.

You can use the context-sensitive help in one of two ways: from the 'Help' menu (see "The
'Help' menu") or by pressing the <KHelp> key (see "Requesting context-sensitive help with
the <KHelp> key").

5.1.1.1 The 'Help' menu

If a window includes a menu bar, the menu bar provides you with a pull-down 'Help' menu
located on the far right of the menu bar. The 'Help' menu contains menu items that allow
you to request help information on the current window.

Help
Context—Sensitive Help  Shift+Help
Overview

Index

Contents

K.eyhoard and Mouse
LIsing Help

Product Information
Figure 34: 'Help' menu

5.1.1.2 Requesting help on the current window

Open the window's pull-down help menu and select one of the following menu items:

Menu item Function
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Context-Se | Allows you to obtain help on a particular
nsitive Help | object in the window (= tsuzrr1+<KHelp>).
When you request context-sensitive help,
the pointer turns into a question mark.
Use this question mark to click on the
object for which you need help

Overview Opens a help window containing
task-oriented information on the current
window (‘Help' pushbutton in windows
without a menu bar).

Index Opens the index search window which
you can use to search for index entries in
help texts.

Contents Opens a help window listing the help texts

available for the current window (‘Help'
pushbutton on the object manager icon
bar).

Keyboard Opens a help window containing
and Mouse information on button and key bindings.

Using Help Opens a help window containing
information on working with the help
system.

Product Opens a help window containing
Information information on the name and version of
the product. You are also provided with a
list of all the help books available in the
SINIX/windows User Environment.

Table 13: Items in the help menu

The 'Help' menu can also include other menu items that allow you access to important
information on the current window.

5.1.1.3 Requesting context-sensitive help with the <KHelp> key

Unlike requesting context-sensitive help from the 'Help' menu, in this case you first select
the component for which you need help, then you request the help. This can be especially
useful if you need information on menu items. You first select the menu item and then press
the <KHelp> key to obtain information about the function of this item. You can, of course,
also use the <KHelp> key in conjunction with other components of the graphical user
interface.

Requesting help for the selected component

1. Using the mouse or keyboard, select the control for which you want help without
activating it. A control is selected when it is assigned the input focus. See section
"Navigating with the keyboard" for information on selecting a control with the keyboard.

2. Press the <KHelp> key ([ueLp] Or [F11).

5.1.1.4 Helpin anicon pop-up menu
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51.15

5.1.1.6

An object is displayed on the graphical user interface as an icon. For example, the desktool
icons are provided by the desktop manager. The desktop manager is an object manager
provided by SINIX/windows (see the chapter "The desktop").

The pop-up menus of all object manager icons include a 'Help' menu item with which you
can request help on the object represented by the icon.

Show contents [

Empty trashcan [
Help |

Remove
Figure 35: A pop-up menu with the menu item 'Help'

Requesting help on an object

Display the pop-up menu for the icon with the mouse button <BMenu> and select 'Help'.
You can only obtain context-sensitive help on a specific object by using the 'Help' menu
"The 'Help' menu") or by pressing the <KHelp> key (see "Requesting context-sensitive help
with the <KHelp> key").

The 'Help' pushbutton on the object manager icon bar

If the icon bar in the object manager has been activated, it appears at the top of the window,
beneath the menu bar " Icon bar". The 'Help' button is the one to the far right on the icon
bar; it displays a question mark (?). You can use this button to request an alphabetical list of
all task-oriented help texts that are available for the current window.

Gl

Figure 36: 'Help' button on the icon bar

Requesting help on the current window in an object manager

Click on the 'help’ button on the icon bar with the <BSelect> mouse button.

You can also obtain help on the object manager by selecting the 'Contents’ item in the 'Help’
pull-down menu of the window.

The 'Help' pushbutton in windows without a menu bar

A window without a menu bar, typically a dialog box, normally contains a 'Help' pushbutton.
You can use this pushbutton to request information on the current window.
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512

| Help -

Figure 37: 'Help' pushbutton

Requesting help on the current window without a menu bar

Click on the 'Help' button on the icon bar with the <BSelect> mouse button.

You can also obtain help on the current window without a menu bar by pressing the
<KHelp> pushbutton.

Using the help system

Once you have found your way into the help mechanism, functions such as the following
are available for your use:

you can display an overview of the help texts

you can navigate through the help text system

you can request associated information and further details

you can search the help texts by index entries

you can use the help system as a source of information
All information in the help system appears in windows. There are two types of windows:
- help windows for displaying help texts
- index help window for searching for help texts on index entries
You can have as many help windows open simultaneously as you like. However, only one
index search window can be open at a time.
You normally access the help system from a help window. This window contains general or
more specific information about the component from which you requested help.
If you want to search for specific index entries in the help system, open the index search
window. To do this, select the 'Index' entry in the 'Help' menu or select the 'Index..." entry
from the 'Navigate' menu if the help window is already open. The index search window also
gives you an overview of the available help books which make up the help texts.
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= SINIX/windows Help 1= 10|l = Keyword search [ = [T
File Mavigate Wiew Help Help books
. Hep 1B
| hep N EEE e e =
>Ing helb Host kanager
Topics concerned A hail hanager 7
Getting help, Mavigating through the _
help text system, Exiting the help Filter for keywords
Getting help Help
. " " . K.eywords
Click the "Help " menu in the menu bar of = - A
the current window and select from the Help, change wview
pull-down menu the item on which you need help Help, context-sensitive
Help, exit
In wlj]rgjdows without a menu bar, click the "Help® Help, exiting application help
pushbLiton Help, keywaord search
There are two ways of requesting Help, request
context-sensitive help, i e help with a Help, requesting —
control Help, with controls
Select th ol withot activating it Help, with the help system
elect the control without activating it, - ; L
and then press the <K Help= key <k Help= il Help, with the window E?_—
Help texts for keyword
cose i -« e RS |
Closing all help windows
Lsing help
v
014 Apphy Cancel Help

Figure 38: Help window and index search window

The following is a description of how to request help on the help system itself. Please refer

to this help text and the help texts that you can open from this text for further

information.

1. Point to the 'Help' desktool and press the mouse button <BMenu>. The desktool pop-up
menu is displayed.

2. Drag the pointer onto the menu item 'Using Help' and release the mouse button.

5.1.2.1 Components of the SINIX/windows User Environment

The SINIX/windows User Environment allows experienced users to modify the configuration

of the desktop in order, for example, to integrate additional applications into the graphical

user interface. These applications are then displayed as desktools on the desktop.

You can use the help system to obtain information on which of the desktools available on

the desktop are actually part of the SINIX/windows User Environment.

1. Select the menu item 'Index’ from the help menu of the 'Main Desktop' window. The
index search window is then displayed with the help book 'SINIX/windows Desktop'
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preselected.

2. Select the index entry 'Desktool’. The help texts belonging to this index entry are
indicated in the list of help texts.

3. Select the help text '‘Desktools overview' and confirm your selection. A help window is
displayed which contains a help text that lists the desktools which are component parts
of the product.

5.1.3 Exiting the help system

You exit help by closing the help system window. You can close each window individually,
several windows simultaneously or all the windows of the help system together.

Closing a help Click the mouse button <BSelect>
window on the 'Close’ pushbutton. The help
window is then closed.

Closing the Click the mouse button <BSelect>
index search on the 'Cancel' pushbutton. The
window index search window is then closed.
Closing an Select 'Close application’s help
application’s windows' from the 'File' pull-down
help windows menu. The current help window and

all help windows opened from the
same application are closed. All
these help windows have the same

window title.
Closing all help Select 'Close all help windows' from
windows the 'File' pull-down menu. All open

help windows on your screen are
closed including the index search
window if it has been opened.

Table 14: Exiting the help system

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600 Page 51



SINIX/windows User Environment V3.0 Introduction to Handling and Configuration  April 1996

5.2 The 'Infothek' desktool

The 'Infothek’ desktool is a collection of several help functions. It is one way to access the
help system. To do this, you press the <BMenu> mouse button to activate the icon's pop-up
menu. Select the 'Main Index' item to open the index window. Then select 'Use Help' to
open a help window. You will find a detailed description of how to use the help system in
section "Using the help system".

In addition, you can use the ‘Infothek’ desktool icon illustrated below to access the dtext
(DynaText) client. This application makes the online documentation available on your
system very easy to use. You can access this manual and its three companions online while
your are working at your computer, provided that your system administrator has installed the
online manuals for the SINIX/windows User Environment.

[Infothek
Figure 39: The 'Infothek' desktool

5.2.1 Displaying online manuals with DynaText

There are two ways to start the DynaText application, which provides you with support in
using the online manuals for the SINIX/windows User Environment and for other products
while your are working: double-click on the icon with <BSelect> or select the 'Online Library’
entry from the icon's pop-up menu.

The main window appears on the screen. It has two list boxes in the window area beneath
the menu bar. The left-hand box contains the libraries which DynaText can access. The
right-hand box contains the books in the respective libraries.

The online documentation for DynaText is always available on your system: you will see the
'‘Dyna Text Documentation' entry in the "Collections" box. This library contains a detailed
description of how to use DynaText. Select this entry and then the entry which subsequently
appears in the '‘Books' box on the right. Click on the '‘Open’ pushbutton.

The 'SINIX/windows V3.0' entry in the 'Collections' box tells you whether the online manuals
for the SINIX/windows User Environment are installed. When you select this entry, the
individual books in this library are displayed in the right-hand field.
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= DynaText « |[]
File Qptions Help
Collections Books
SIMI R Awindows VE 2 Clients
CynaText Documentation Guide for Experts
Handling and Configuration
#0CL
Search I || [O] wvege || 008 H
Update 4 Off € On Sort By 4 Frequency 4 Alphabet
sSearch Feset || Dpenl

Figljre 40: 'DynaText' main window

You can enter a search word in the 'Search’ box of the main window and have Dynatext
search the books in the selected library for this word. To do this, click on the 'Search'
pushbutton. When the search is completed, numbers appear after the book titles in the
right-hand box. These numbers indicate the number of times the search word was found in
the individual books. This allows you to open the specific books which contain the
information you are seeking.

After you select an entry and press the 'Open’ pushbutton at the bottom of the window, the
display window opens and the online version of the appropriate manual appears on the
screen. For example, you will find the current manual under the name '‘Operation’ in the list.
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=| Handling and Configuration:fulltext = |
‘ File Edit  VYiew  Search Annotations Help
7

= SINIXfwindows User
Environment V2.1
Introduction to Handling and
Configuration

6.1 Desktop manager

The desktop manager provides you with a number of desktools that are represented
as 1cons In the atiginal SINEKAwindows configuration, several of the available
desktools along with a number of toolboxes, in which additional desktools are
stored, are displayed on the deskiop

You can also caonfigure the desktop according to your indradual needs In
particular, you can change the contents of the toolboxes by removing existing
desktools or creating new desktools The desktop manager includes a deskiools
catalog that enables you to add desktools to the deskiop

Preface

Input devices
Logging in and out
Controls

6.1.1 The desktop and toolhoxes

You can use the toolboxes to reduce the clutter on your desktop You can, for
example, place desktools that provide similar functions together in a toolbox. In the
ariginal configuration, the Main Desktop” window includes not anly several
desktools but also a number of toolboxes

1|

Help system, manual
pages, online manuals

=8 The desktop
Deskiop manager
£ 11 The desktop and toolboxes
Deskiools
Desktools catalog
Ohject manager icons
Actions on the deskiop

’E“ Main Desktop

‘Elle Edit ‘“iew Options

57 Using desktools

[Aoplications|

8 References

Glossary

Index

Figure 42 Toolboxes in the Main Desktop” window

INE

Figjure 41: Displaying the online manuals with DynaText

5.2.2 Using DynaText

Unlike the hardcopy version, you can use Dynatext, for example, to display selected
information such as the illustrations or tables in a document. You can also quickly go
directly to the desired passage in the online manual. If you do not know where the desired
information is located, Dynatext provides an easy-to-use search system. You can use this
search system, for example, to find out how many times a search word occurs and where it
occurs in the document. You can use some of these options, and others, in the "View' and
'‘Search' menus illustrated below.
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Figure 42: 'TOC View' in in the 'View' menu of the DynaText display window

Search Annotations

show Search Panel

Cancel Search

HEEN PR PP

|F':”T”5—E:’||$Standard
search History Title Search
Mew History Title Words
:[Cpen Proximity Search
| =ave
Save As

Femove History
Figure 43: 'Forms' in the 'Search’ menu of the DynaText display window

If you need more information on running DynaText, use the 'Help' menu in the various
windows as well as the online "Dyna Text Documentation'.

5.2.3 Exiting DynaText

To exit DynaText, close all display windows and the main window. You can use the relevant
items in the "File" menu of the respective windows.
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5.3

531

53.2

53.2.1

The manual pages

If your system administrator has installed the online manual pages for the SINIX/windows
User Environment, you can display descriptions of the clients with the 'Manuals' desktool.
The clients are documented in the "SINIX/windows User Environment; Client's Reference
Manual”. You can also use the 'Manuals' desktool to access the online manual pages of
other products.

Displaying manual pages

The 'Manuals' desktool icon shown below represents the xman client. xman does not have
any of the OSF/Motif controls described in the chapter "Controls".

Fanuals
Figure 44: 'Manuals' desktool

Using the 'Manuals' desktool

The help system does not support the ‘Manuals' desktool. You can, however, display an
English manual page in the 'Manuals' window by clicking on the 'Help' pushbutton. This
manual page provides you with information on the following:

- scrolling

- the function of all menu items

- various mouse and keyboard actions

- using the search mechanism

- accelerators and mnemonics

'Manuals' window

When you call this desktool, the 'Manuals' window is displayed.

= fManuaIs - Iﬁ

Hanual Browuser

|(_Help ){_ouit )|

(: Hanual Page :]I

Figure 45: 'Manuals' window

It contains three pushbuttons, grouped under the name ‘Manual Browser', which have the
following functions:
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Pushbu Function

tton

Help Opens the 'Help' window which contains a
manual page describing how to use the
desktool.

Quit Exits the desktool.

Manual Opens the ‘Manual Page' window, which

Page initially displays information on how to use
the desktool.

Table 15: Push buttons in the 'Manuals' window

5.3.2.2 'Manual Page' window

The 'Manual Page' window is displayed when you click on the ‘Manual Page' pushbutton in
the 'Manuals' window using <BSelect>.

The window contains a menu bar with the 'Options' and 'Sections' menus and a text output
box, as well as a non-editable text area in which the manual pages are displayed. If
necessary, the window also includes a scroll bar.
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—

Manual Page =[]

ptions [Sections | Xnan Help

XMAN iz an X Window Systermn manual browsing toaol, built upon

CREDITS

YVersion Use "Show Version' menu item

EBaszed Upon Eman for 10 by Barry Bhein — Boston Univ
Written By Chris D Peterson — MIT X Consortium
Copyright, 1988, 1989 Massachusetts Institute of Technology

GETTING STARTED

Ev default, xman starts by creating a small window that contains
three "buttons" (places on which to click a pointer button)  Twwo of
these buttons, Help and Guit, are self explanatory  The third, Manual
Page, creates a new manual page browser window; you may use this
button to open a new manual page any Hme Xman is running

& new manual page starts up displaying this help information The
manual page contains three sections  In the upper left corner are two
menu buttons  When the mouse is clicked on either of these butions a
menu is popped up  The contents of these menus is described belowr
Directly to the right of the menu buttons is an informational display
This display usually contains the narme of the directory or manual page
being displayed Itisalsoused to display warning messages, and the
current version of xman  The last and largest section is the
information display This section of the application contains either
a list of manual pages to choose frorm, or the text of a manual page

To use xman just pull down the sections menu to select a manual
section, once the section is displayed click the left pointer button
ot the narme of the manual page that you would like to see Kman will
autormatically replace the directory listing with the manual page that
has been selected

Figure 46: 'Manual Page' window

The 'Options’ menu contains the following menu items:

Menu

item Function
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Manual Page

Display Displays a list of available manual
Directory pages in the text area.
Display Retrieves the previously displayed

manual page if you have displayed the
list of topics.

Help Displays the manual page on using the
desktool in a new window.

Search Opens a dialog box for searching for an
index entry.

Show Both Splits the text area into two so that you

Screens can simultaneously display the list and
the manual page.

Remove This Closes the current window.

Manpage

Open New Opens a new window.

Manpage

Show Version

Displays information on the version of
the desktool in the text output box on
the menu bar.

Quit

Terminates the desktool.

Table 16: Items in the 'Options' menu in the ‘Manual Page' window

The menu items on the 'Sections' menu allow you to determine which type of manual page
is to be displayed in the list of topics; for example, commands, system calls or file formats.
The number of menu items varies depending on which online manual pages are installed.

Manual pages on the SINIX/windows User Environment

It is assumed that the manual pages for the SINIX/windows User Environment have been

installed and the desktop is still in its original configuration:

1. Open the 'System’ toolbox on your desktop by double clicking on the appropriate icon
with the mouse button <BSelect>.
2. Start the 'Manuals' desktool by double clicking on the icon with the mouse button
<BSelect>. The 'Manuals' window is displayed.
3. Click on the 'Manual Page' pushbutton with <BSelect>. The 'Manual Page' window is
opened, and the manual page on using the 'Manuals' desktool is displayed in the text

area.

4. Select 'User Commands' from the 'Sections' menu. A list of command names for which
manual pages exist is displayed in the text area.
5. Click on a command name with <BSelect>. After a brief interval the appropriate manual
page is displayed in the text area. The list of topics may include other command names
in addition to the client names.

Quitting manual pages

You can terminate the display of manual pages by exiting the 'Manuals' desktool. Any
number of ‘Manual Page' windows may be open at any one time, and you may close each
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of these windows individually.
5.3.4.1 Exiting the 'Manuals' desktool

Click on the 'Quit' pushbutton in the 'Manuals' window with <BSelect>. You can also select
the menu item 'Quit’ from the 'Options' menu in each ‘Manual Page' window.

5.3.4.2 Closing the 'Manual Page' window

Select 'Remove This Manpage' from the '‘Options' menu. The window is closed but the
'‘Manuals' desktool is not exited.
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6 The desktop

You can compare the desktop of the SINIX/windows User Environment with a model that
you are familiar with: your desk. On your desk you have documents and forms with which
you work, which you take out of folders and put away again. You probably also have other
work aids on your desk such as a typewriter, mail trays and a pocket calculator.

You will find these and other tools on the SINIX/windows desktop. The tools on the desktop
are represented by graphical symbols known as icons. An icon may represent an
application (equivalent to, say, a typewriter), text files (equivalent to letters) or directories
(equivalent to folders).

The applications, together with their icons, are referred to below as desktools. The
desktools are supplied by one of the central components of the desktop, the desktop
manager.

You will find other object managers represented as desktools on your desktop: the file
manager, communication manager, user manager, host manager, NFS manager, volume
manager, software manager, and audio manager. Just as the desktop manager manages
desktools, the file manager manages files and directories, the user manager manages user
accounts on the system, etc. In other words, each of these object managers provides a
separate set of objects which you can process as icons.

The object manager icons provided by the desktools can all be manipulated in different
ways: the icons can be arranged in the window according to your individual preferences. To
avoid clutter on your desktop, the desktop manager provides you with toolboxes in which
you can place desktools in accordance with your own particular needs. The desktools
catalog provides you with an overview of the desktools.

All desktools have pop-up menus which you can use to start specific actions for the objects.
In addition to the object managers, there are other desktool objects which you can display in
the form of icons.

The icons on the desktop can be operated with the mouse. You use the icon to invoke an
action for the object represented by the icon. Just as you would put a piece of paper in your
typewriter, you can drag the icon representing a text file to the 'Editor' desktool and drop it
there. As a result, a window is opened in which you can edit the file.

In the original configuration, the desktop shown below is displayed on your screen once you
have successfully logged in to the system (see section "Logging in").
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Figure 47: The factory default desktop configuration

In figure "The factory default desktop configuration" you see the desktop manager's ‘Main
Desktop' window and the icon box. In the windows you will recognize several controls that
were described earlier: multiple windows, the window manager controls and a menu bar. As
the system administrator can modify this configuration system-wide and the user can modify
it for his or her login name, the appearance of the desktop on your screen may be different.

6.1 Desktop manager
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6.1.1

The desktop manager provides you with a number of desktools that are represented as
icons. In the original SINIX/windows configuration, several of the available desktools along
with a number of toolboxes, in which additional desktools are stored, are displayed on the
desktop.

You can customize the desktop according to your individual needs. You will not need to use
all desktools every day. Configure the desktop so that it best suits your work habits. In
particular, you can change the contents of the toolboxes by removing existing desktools or
creating new ones. The desktop manager includes a desktools catalog that enables you to
add desktools to the desktop; this is described in the section "Desktools catalog”.

The desktop and toolboxes

You can use the toolboxes to reduce the clutter on your desktop. You can, for example,
place desktools that provide similar functions together in a toolbox. In the original
configuration, the 'Main Desktop' window includes not only several desktools but also a
number of toolboxes.

File Edit View Options Help

IEAppIicationsi Images System Auto-Start

Figure 48: Toolboxes in the 'Main Desktop' window

You open a toolbox by double-clicking on the associated icon with <BSelect>. The
desktools contained in the toolbox are then displayed. You can use the menu item 'New
window on navigate' on the ‘Options' menu to specify whether the contents of the toolbox
are to replace the contents of the current window or are to be displayed in a separate
window. If you open several windows, you can work with the desktools contained in different
toolboxes simultaneously.

Toolboxes can also contain other toolboxes. You can therefore organize your desktools in a
tree-like structure and use the icons representing the toolboxes to move around this
structure. The window title indicates the level you are currently on.

The 'Main Desktop' is the root of the tree; in other words it is essentially the toolbox that
contains all the other toolboxes. You can also recognize the ‘Main Desktop' by the fact that
it does not contain a toolbox with the label 'parent’, which allows you to move to the parent
toolbox by double-clicking on it. You can also display the tree-like structure of the toolboxes
in the window by changing the view of the icons (see section "View of icons").

You create a new toolbox by selecting 'New' from the 'File' menu. You can modify the
attributes of an existing toolbox by selecting the toolbox involved and then selecting 'Modify’
from the 'Edit' menu. You can move desktools from one toolbox to another by dragging
them from one toolbox and dropping them onto the other (see section "Dragging and
dropping icons"), thus quickly reorganizing your desktop.

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600 Page 63



SINIX/windows User Environment V3.0 Introduction to Handling and Configuration  April 1996

6.1.1.1 The 'Auto-Start' toolbox

The 'Auto-Start' toolbox has an expanded functionality which distinguishes it from the other
toolboxes: desktools located in this special toolbox are called automatically each time you
start up the desktop manager.

I Auto—Start
i:igure 49: Icon of the 'Auto-Start' toolbox

For example, if you want a clock to appear on the screen from the very beginning of each
subsequent session, copy the icon of the 'Clock’, desktool to the 'Auto-Start' toolbox. Refer
to the section "Dragging and dropping icons” for instructions on how to copy icons. When
you exit the desktop, enter 'Yes' when the system asks whether you want to save the
current configuration. The 'Clock’ application will be started at the beginning of the next
session and the clock will appear on the screen.

Of course, you can manipulate and exit any of these automatic applications in the usual
way. If you no longer want the application to be executed automatically at the beginning of
the session, remove the application's icon from the 'Auto-Start' toolbox and save the current
configuration by selecting the ‘Save' item from the 'File' menu on the menu bar.

6.1.2 Desktools

The desktop provides a number of desktools. These desktools can be contained in various
toolboxes. The icon representing a desktool will give you an idea of what the desktool does.
For example, the label of the 'Clock’ desktool indicates the name of the desktool and the
icon image is a picture of a clock.

Clock
Figure 50: Icon of the 'Clock’ desktool

A desktool normally represents exactly one application. It is, however, possible to
incorporate a number of applications in a single desktool, as is the case with 'Editor'.

The application normally provides you with a graphical interface which facilitates working
with the application program. The icon's pop-up menu contains menu items with which the
application is called. Many applications open a window which prompts you for more detailed
information on the action you have invoked; others execute the selected function
immediately. If you are not certain which action will be performed, use the icon's pop-up
menu to obtain help information on the desktool.

You can use the desktools as supplied, or you can modify the appearance and behavior of
a desktool by modifying the icon image, the label or the action invoked by the icon. To do
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this you select the desktool you wish to modify and then select the menu item 'Modify' from
the 'Edit' menu.

The menu item 'New' on the 'File' menu enables you to create new desktools and thus
provides you with a means of starting other applications directly from your desktop.

6.1.3 Desktools catalog

The desktools catalog provides you with an overview of all the desktools that the desktop
manager normally provides. The catalog is a window in the desktop manager which you
open by selecting 'Desktools catalog' from the 'Options' menu.

Unlike the desktop main window, where you can remove desktool icons according to your
individual preferences, you will always find all desktools (and one corresponding icon) in the
catalog window. For example, if you need a desktool whose icon was removed from the
desktop, you can start it from the desktools catalog. If you want to use this icon frequently in
the future, copy it from the catalog to the desktop main window and save the current
desktop configuration by selecting 'Save' from the 'File' menu.

To close the desktools catalog, select 'Close Window' from the "File" menu on the menu bar
of the desktools catalog window.
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6.2

6.2.1

Object manager icons

The desktop manager is just one example of the object managers available in the

SINIX/windows User Environment. The objects managed by the desktop manager are the

desktools. You will find other object managers provided as desktools on your desktop,

including the file manager, the mail manager, the user manager, the host manager, NFS

manager, the volume manager, and the software manager.

Each object manager manages its own set of objects. These objects are represented as

icons that the user can work with. All object manager icons share several identical

attributes.

- Icons are displayed in windows by the object managers. The icons can be displayed in
these windows in various different ways.

- lcons include a pop-up menu that can be used to invoke actions involving the objects
they represent.

- For many object managers icons can be removed from a window by throwing them in the
trash.

View of icons

All object managers display their icons in windows. The objects associated with these icons
can be manipulated via the pull-down menus included in the menu bar. The desktop
manager is the only object manager that can be configured in such a way that its objects
are displayed in the root window. This is done using the 'Preferences' desktool. In such a
configuration, the desktop manager itself is available as a desktool.

You can use the menu item 'Window' on the 'View' menu to modify the view of an object
manager window. For many object managers the menu item 'Window' contains a cascade
menu with the items 'Overview', '‘Browser' and 'Split Browser'. The menu items include
check buttons that indicate the current view of the window.

'‘Browser', for example, is the view type that you see in the '‘Main Desktop' window if the
desktop manager is started in its original configuration.
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Figure 51: 'Main Desktop’ window with the 'Browser’ view

Object managers can also display their icons in paned windows. Paned windows are
described in the section "Paned window".

If, in the 'Browser' view, different types of objects are being displayed, e.g. files and
directories, you can display the different types in separate window panes. To do this you
select the menu item 'Split Browser'.

The manner in which the objects are subdivided into types depends on the object manager.
The desktop manager, for example, separates toolboxes from desktools; the file manager
splits up files and directories. The user manager, however, displays only one type of object,
the users, so in this case the 'Split Browser' menu item has no effect on the view.
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Figure 52: 'Main Desktop' with the 'Split Browser' view

Another way of displaying objects in context can be selected via the menu item ‘Overview'.
You are then provided with an overview of the objects displayed in the object window.
What the overview looks like depends on the objects involved. For example, the user
manager displays an overview of user groups, the host manager an overview of computer
networks. The file manager, on the other hand, displays the directory structure starting at
the current directory, and the desktop manager displays the tree-like structure of the
toolboxes.
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6.2.2

6.2.3
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Figure 53: 'Main Desktop' in the 'Overview' view

Icon pop-up menu

Each icon belonging to an object manager has its own pop-up menu. The menu items on
the pop-up menu enable you to perform actions on the object represented by the icon.
The entries included on the menu depend on the object represented by the icon. For
example, desktools can be started via the menu, files edited or printed, and mail read or
stored.

All'icons include the following menu items:

Menu Function

item

Help Displays help information on the object or
object type.

Remov Removes the icon from the window and

e throws it into the trash. Please note that
desktools and toolboxes are removed from the
desktop but are not thrown into the trash.

Table 17: Items in the pop-up menu of an icon

Trash

For many object managers icons can be removed from the window and the associated
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object thrown into the trash. An object is thrown into the trash either by selecting 'Remove’
from the pop-up menu or by dragging the object onto the 'Trash' desktool and releasing it.
"Trash' acts as a buffer for objects that are no longer needed. You can retrieve these objects
at any time using the 'Trash' desktool as long as you have not explicitly emptied the
trashcan. Once the trashcan has been emptied, the objects have been deleted and can no
longer be accessed.

You can throw any object manager icon into the trash. The objects are associated internally
with the appropriate manager. You can then use the 'Trash' desktool to access the trash
belonging to a specific object manager. You can, for example, take a look at all the files in
the trash and delete all the mail thrown into the trashcan. The menu items of the Trash’
desktool for viewing and emptying the trash contain cascade menus from which you can
select the desired objects.

Ehnw contents P
Empty trashcan [

- |
Show file trash

Show mail trash

Help

show user trash

Remoyve Show host trash
Figure 54: Pop-up menu of the Trash' desktool’

The objects belonging to the desktop manager are an exception. They can be removed
from the desktop as described above, but they are not thrown into the trash. You can only
restore a desktool if the desktools catalog contains a copy of the desired desktool.

Note:

Toolboxes and their contents and desktools you have created yourself cannot be
retrieved once they have been removed from the desktop.
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6.3

6.3.1

6.3.1.1

Actions on the desktop

You can manipulate objects easily by manipulating their representation on the screen using
the mouse. An object can be a desktool, a file, a file name or a text, for example. The
objects can be displayed as icons (desktool, file or file name) or as text in a text area.
Before you can work with objects, you must first select the objects you wish to work with
from the set of available objects. Objects that are represented as icons are chosen by
selecting the associated icon. The help texts provide you with information on selecting and
deselecting icons with the keyboard.

You can process the selected objects by dragging them to a different position on the
graphical user interface and invoking an action there. You can drag and drop a single icon
without having to select it first. The results of doing so depend on the objects being
dragged, the selected action and the release position. In order to select a single action from
a number of possible actions, you can press a defined key in combination with the mouse
operation.

If you wish to be able to access several frequently used actions quickly, you can assign an
action to a control; this action is then invoked when you double-click on the control.

Certain actions invoked via the graphical user interface expect text input on your part. For
example, a dialog box may be displayed in which you are prompted to enter the directory
that you want the file manager to display. The section on "Copying and moving text" (see
section "Cut and paste functionality”) provides you with an explanation of how to select text
in a window using the mouse and copy it into another window.

Selecting and deselecting icons

In order to perform a particular action involving an icon, you must first select the relevant
icon: for example, if you want to select one of the items on the 'Edit' menu in a file manager
window. You can, however, drag and drop a single icon without selecting it first.

You can save a great deal of time by executing the same action on several icons
simultaneously, for example if you want to delete several files or send them as mail. For this
reason the desktop provides you with a means of selecting several icons simultaneously.

If a window in which you can select icons (e.g. a file manager window) is active, you will see
an outline around one of the icons. This is known as the selection cursor and indicates
which icon will be affected by keyboard input.

Selecting a single icon

Point to the desired icon and click <BSelect>.

The icon is selected. This is indicated by the fact that the name of the icon is displayed in
reverse video. If you subsequently select a different icon with <BSelect>, the original
selection is cancelled.
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Figure 55: Selecting an icon by clcking with <BSelect>

6.3.1.2 Selecting icons within a rectangle

In order to select a number of icons within a rectangle, you indicate an anchor point and
then drag the pointer to the end point, i.e. the diagonally opposite corner of the rectangle:
Point to the anchor point of the rectangle and press <BSelect>. Drag the pointer to the end
point of the rectangle.

All icons located within the rectangle defined by the anchor point and the end point are
selected.
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Figure 56: Selecting by dragging with <BSelect>

6.3.1.3 Extending the selection by a single icon

Point to an icon that has not yet been selected and click with <BToggle>, i.e. press [cTrL]

+<BSelect>.
This icon is now also selected.
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Figure 57: Selecting by clicking with <BToggle>

6.3.1.4 Extending a selection by a number of icons within a rectangle

Once you have made a selection, you have defined an anchor point that can be used for
extending the selection by a number of icons located within a rectangle. All you have to do
is define the end point of the rectangle:

Point to the end point of the rectangle and click with <BExtend>, i.e. press [suIFT]
+<BSelect>.

All'icons located within the rectangle defined by the anchor point and the end point are
selected.
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Figure 58: Selecting by clicking with <BExtend>

6.3.1.5 Deselecting individual icons

Point to a selected icon and click with <BToggle>, i.e. press [crru] +<BSelect>.
The icon you click on is deselected; all other icons remain selected.
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Figure 59: Deselecting by clicking with <BToggle>

6.3.1.6  Deselecting icons within a rectangle

Once you have performed a deselection, you have defined an anchor point that can be

used to the icons located within a rectangle from the selection. To do this, you must drag

the mouse from the anchor point to the end point of the rectangle.

1. Point to the anchor point of the rectangle that you wish to deselect.

2. Press <BExtend>, i.e. 1surrr] +<BSelect>, and drag the pointer to the end point of the
rectangle.

All the icons located between the anchor point and the end point are deselected.
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Figure 60: Deselecting by dragging with <BExtend>
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6.3.1.7 Deselecting all icons

You can deselect all selected icons with a single action:
Point to an empty space in the window and click <BSelect>.
None of the icons is now selected.
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6.3.2

6.3.2.1

' |chapﬂB| |chapﬂﬂ|

Figure 61: Deselecting all icons by clicking with <BSelect>

Dragging and dropping icons

The drag-and-drop mechanism enables you to move objects to a different position on the
graphical user interface and drop them there, thus invoking a specific action, e.g. loading an
image file into an appropriate editor. Using the keyboard, you can specify more exactly
which action is to be invoked: for example, whether a file is to be copied or moved to a
different directory. You can drag and drop not only objects belonging to the object
managers but also text, e.g. text located in labels, lists and text boxes.

Picking up objects

1. Point to the object that you want to drag. If you wish to pick up several icons, you must
first select the relevant icons (see section "Selecting and deselecting icons™) and then
point to one of the selected icons. If you wish to pick up text, the text must be selected
first (see section "Cut and paste functionality").

2. Press and hold down the mouse button <BTransfer>.

Once you have picked up a draggable object, the pointer changes its shape. It is either
displayed as a symbolic representation of the drag operation or as an image of the object
that has been picked up. If you pick up a file, for example, you see the icon image of the
file.

© Siemens Nixdorf Informationssysteme AG Ident.: 08902-J-2145-6-7600 Page 77



SINIX/windows User Environment V3.0 Introduction to Handling and Configuration  April 1996

6.3.2.2

6.3.2.3
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Figdre 62: Picking up objects

Dragging

Drag the pointer across the desktop to the position at which you wish to release the object.
You can cancel the drag operation at any time by pressing the [esc1 key.
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Figljre 63: Dragging to release position

Determining the release position

As you drag the pointer across the desktop, you can obtain information about possible
release positions for the object being dragged by either requesting help or by looking at the
"drag effects".

The drag effects are indicated by the different forms the pointer takes and the graphical
representation of the point at which the pointer is currently located. You can use the
'Preferences' desktool to specify whether and which drag effects are displayed.

Help during dragging: You request information about a release position by pressing the
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<KHelp> key. You can then decide whether to release the object or cancel the
drag-and-drop operation. If you wish to select a different release position, you must pick up
the object again. If the object cannot be placed at the release position, the operation is
aborted without help information being displayed.
Drag over effect: The pointer is used to symbolize the action that is invoked once the
object is released:

MovePointer is displayed as a single document

CopyPointer is displayed as two documents
The drag over effect enables you to determine whether releasing an object will invoke the
desired action without pressing a key. If no drag over effect is displayed, releasing the
object will not initiate any action.
Drag under effect: The changing representation of the object on which the pointer is
located indicates that an action will be invoked for the object being dragged when it is
released.
For example, an open toolbox indicates that a desktool can be placed in that toolbox.
Window areas in which an object can be placed may also be highlighted by a frame.

6.3.2.4 Selecting an action

By pressing a key, you determine the action that is invoked when the object involved is
released:

MovePress the [surrr] key

CopyPress the [cTrr] key
If you do not select an action when you release an object, the first mutually compatible
action for the dragged object and the release position is determined in the order "Move" and
"Copy".

6.3.2.5 Dropping

Determine the exact release position for the object being dragged: the hotspot, i.e. the point
on the graphical user interface for which a mouse action is registered, is symbolized in the
pointer by the tip of an arrow. In general, the upper left-hand corner of the pointer
determines the hotspot.

Release the mouse button <BTransfer>.

If the object is accepted at the release position, the pointer merges into the image at the
release position. If not, the pointer jumps back to the position at which the object was picked
up and no action is performed.
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6.3.3

6.3.4

6.3.4.1

6.3.4.2
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Figdre 64: Releasing the objects

Double-clicking

Double-clicking with the mouse button <BSelect> on an object invokes the predefined
action for that object. You can use the 'Mouse' desktool to change the maximum interval at
which two clicks will be interpreted as a double click.

Defining this action is only of any use for a small number of objects. One example was
already presented in the chapter headed "Controls": double-clicking on a minimized window
returns the window to its previous size. This action is equivalent to selecting 'Restore' from
the icon menu. The double click replaces several individual steps: in the above-mentioned
example these steps were opening the menu and selecting the menu item.

Actions that are invoked after a double click have also been defined for object manager
icons. In the original configuration, the action that is invoked is identical to the action
invoked by the first item on the icon's pop-up menu.

Cut and paste functionality

You can use the mouse to select text from a window, copy it to a buffer (the cut buffer) and
paste it in the same window or a different one. This applies both to terminal emulator
windows and to areas of a window in which text can be entered. The text is stored in the cut
buffer and can be retrieved at any time. Refer to section "Dragging and dropping icons" for
information on how to move text using the drag-and-drop mechanism.

Selecting text character by character

Position the pointer on the first character of the text you want to select, and press and hold
down the mouse button <BSelect>. Drag the pointer to the last character of the text. The
text is visually highlighted. As soon as you release the mouse button, the selected text is
copied into a global text buffer, known as the cut buffer.

If you copy excessively large amounts of data into the buffer, some of the data may be lost.

Selecting text word by word or line by line
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6.3.4.3

6.3.4.4

Double-click the mouse button <BSelect> on the first word of the text that you want to select
and drag the pointer to the last word of the text. Triple-clicking <BSelect> enables
line-by-line selection.

Changing the size of the selected text area

Clicking the mouse button <BCustom> enables you to change the size of the selected text

area:

1. Point to what is to be the new edge of the selected text area.
If the pointer is currently located inside the selected text area, the selection is reduced; if
the pointer is located outside the selected text, the selection is extended.

2. Click with the mouse button <BCustom>.
The size of the selected text area is reduced/extended character by character, word by
word or line by line up to the position of the pointer depending on the selection mode
used to select the text area.
Multiple clicking using the mouse button <BCustom> changes the selection mode as
described for <BSelect>. In other words, double-clicking <BCustom> allows you to
extend or reduce the text area (selected character by character) word by word.
Double-clicking <BCustom> again allows you to change the selected text area line by
line.

sample_WindoWA

mbackgroun
xforeground:
mWmxactiveForeground:
mWmxactiveBackground:
mWmxfontlList:
mWmxuseIconBox

sample_WindoWw_2

"Abb.19Hi Lfsda

Figure 65: Selected te>:<t

Pasting text
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6.3.4.5

Position the text cursor where you want the selected text to be pasted; this may be in the
same window or a different one. Click the mouse button <BTransfer> to start pasting the
text from the cut buffer in at the cursor position. The client involved treats this text in the

same way as input from the keyboard.

sample_WindowW1

hackground
foreground: black
wm¥xactiveForeground:
wm¥xactiveBackground:
WmxfontList:
WmxuseIconBox:

sample_WindoW_2

mWmxfontlist: gs-24
mWmkuseIconBox: truelj

Figure 66: Pasted text

Pasting text chunks together

To paste a number of chunks of text together, repeat the cut and paste function as often as
you want but make sure you do not include unwanted newline characters when selecting

the text.
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7 Using desktools

The desktools provide you with access to central SINIX/windows User Environment
applications. The desktools are incorporated in the desktop where they are represented as
icons, thus making them easy to operate with the mouse.

This chapter introduces you to working with the desktools. You will learn, for example, how
to use a combination of desktools to perform certain tasks: creating an image and
displaying it as an icon or configuring the desktop on your system to meet your own
particular needs. Initially you will perform the above-mentioned tasks on the desktop in its
original configuration. You will then be provided with information on configuring your working
environment.

Once you have learned how to call and exit desktools in section "Calling and exiting
desktools", the section "Preparing to work on the desktop” introduces you to various tools,
several of which have already been described in the chapter "Help system, online manuals,
manual pages". The other sections deal with creating and editing a text file (see section
"Creating, editing and mailing text files"), creating and editing an image file (see section
"Creating and editing an image file") and the further processing of files (see section
"Processing files"). The final sections deal with configuring your working environment on the
local host (see section "Configuring the working environment for the local host") and on
remote hosts (see section "Configuring your working environment for remote hosts").

You will find that having the same desktool on the desktop in various configurations makes
your work much easier. This is especially useful for desktools such as the file manager,
which can also be started on remote hosts. The section "Saving the current configuration”
tells you how to save your configuration so that it is made available to you the next time you
log in.

Keep only those desktools open that you actually need for your current task. This will keep
your screen free of clutter and save system resources at the same time.
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Figure 67: Desktools in the desktools catalog

The table below provides you with an overview of the tasks described for each desktool. It is
normally also possible to perform tasks other than those mentioned here with a desktool.
The following sections provide you with a brief description of the desktools that can be used
to perform various tasks. You will also find information on the effect of a double click or the
effect of dropping an object. For more detailed information call up help on the relevant

desktool.
Desktool Function?®
Calculator Display calculator
section "Displaying the calculator"
Clock Display time
section "Displaying the time"
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Color & Font | Modify fonts in windows
section "Changing the fonts in windows"
Communicat | Transfer file to communication manager
ion Manager | section "Transferring a file to the
communication manager".
Send mail
section "Administering user accounts"
Editor Edit text file
section "Editing a file"
Emulator Grant access to remote host
section "Granting access to remote hosts via
terminal emulators”
File Compress and decompress file
Compressor section "Compressing a file"
File Create file
Manager section "Creating a file with the file manager"

Configure for remote host
section "Managing files and directories on
remote hosts"

Font Service

System administration
section "Configuring your working environment
for remote hosts"

Hardcopy Create image file
section "Creating an image"
Print image file
section "Printing a file"
Help Request help on a desktool
section "Displaying the time"
Host System administration
Manager section "Configuring your working environment
for remote hosts"
Select remote host for desktool
section "Managing files and directories on
remote hosts"
Image Make image file available as icon image
Browser section "Using an image file as an icon image"
Information Display information on system status
section "Displaying manual pages"
Infothek Display manual pages

section "Displaying online manuals”

Lock Screen

Interrupt session, configure Screen Saver

/ Screen section "Interrupting a session”
Saver
Manuals Display manual pages
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section "Displaying online manuals”

Mouse Set time interval for double click
section "Setting the time interval for double
clicks"
National Configuring a country-specific user
environment
section "Configuring a country-specific user
environment”
NFS View file systems accessable via NFS
Manager section "Viewing a file system accessable via
NFS"
Pixmap Create icon image, edit image
Editor section "Editing an image and creating an icon
image"
Preferences Select text editor
section "Editing a file"
Save desktop status on exit
section "Saving the current desktop
configuration upon termination”
Printer Print file
section "Printing a file"
Configure for remote host. Print file on remote
printer
section "Accessing a remote printer”
Trash Remove file and mail, restore object, delete
object
section "Removing objects"
Shutdown Shutting down or restart a host
section "Shutting down the local host"
User Administering user accounts
Manager section "Administering user accounts"
Volume View file system stored on CD-ROM
Manager section "Viewing a file system stored on a
CD-ROM"
Save file
section "Saving a file on floppy disk or streamer
tape"
Window Activate windows by moving pointer
Manager section "Activating a window by moving the
pointer”
X Terminal System administration
Administrati section "Configuring your working environment
on for remote hosts"

Table 18: Functions described for desktools
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7.1

7.1.1

7.1.2

YA page number in bold type refers to the page in the manual you can turn to for a brief
description of the desktool.

Calling and exiting desktools

You call a desktool by means of its icon; desktools are exited using the controls in the
desktool window, provided that the desktool opens a window.

Calling a desktool

Desktools can be called in a number of ways using their icons:

- You can activate or call most desktools by double-clicking on the associated icon with
the mouse button <BSelect>.

- Most desktool icons can also be called via their pop-up menu:
Point to the desktool icon, press <BMenu> and select the 'Run' command from the
pop-up menu that is subsequently displayed. Several pop-up menus include menu items
that can be used to call the desktool in a number of different ways. For example, when
you start the 'Clock’, you can decide whether to display the time in analog or digital
form.

- Several desktools can also be called by dragging and dropping one or more objects onto
the desired desktool icon (see section "Dragging and dropping icons").

If a desktool opens a window, a window manager icon is displayed in the icon box.

=
-

= Active Applications g

@

Main/Sy [ pimape: e

Figure 68: Icon box

Exiting desktools

There are three ways of exiting a desktool:

1. In windows without a menu bar, click with the mouse button <BSelect> on the ‘Cancel’
pushbutton.

2. If the window contains a menu bar, select 'Exit' from the first menu (on the far left) .
Several windows also include a menu item for closing the current window.

3. If you do not see either of the above-mentioned controls in a desktool window, you can
terminate the application by selecting the 'Close’ command from the window menu.

As soon as you exit a desktool, the corresponding primary window and any associated
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secondary windows are closed. The icon representing this desktool disappears from the
icon box.
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7.2

7.2.1

7.2.2

7.2.3

Preparing to work on the desktop

April 1996

This section explains how to display information and how to prepare your desktop for work.

Displaying the calculator

Calculator
calls a pocket calculator.

Double-clicking
opens a window
containing the
calculator.

Dragging and
dropping

an object has no
effect.

The 'Calculator' desktool is one of the work aids that you can call via the desktop.
Double-clicking on the 'Calculator’' icon opens a window in which a calculator is displayed.
You press the buttons on the calculator with the mouse button <BSelect>. The calculator
also accepts keyboard input.

Displaying the time

Clock

calls a clock with analog or digital display.

Double-clicking
opens a window
in which an
analog clock is
displayed.

Dragging and
dropping

an object has no
effect.

Clock

Start the 'Clock’ using the various menu items on the pop-up menu and compare the various
displays. If you are the system administrator, you can change the date and time using the
'‘Date & Time' desktool. You can change the international formats using the ‘National'
desktool. For more information, refer to section "Configuring the working environment for

the local host".

Displaying online manuals

Infothek

displays the online manual available on the system.

Double-clicking
opens the
'Infothek'’
window
containing
pushbuttons for
displaying online

Dragging and
dropping

an object has no
effect.
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| manuals. | | |

Refer to section "The 'Infothek’ desktool" for a description of how to use the ‘Infothek’
desktool window and to run DynaText, which enables you, among other things, to display
the online manuals for the SINIX/windows User Environment.

You can use the software manager described in section "Managing software" to check
whether the online manuals are available on your system.

724 Displaying manual pages

Manuals
displays the online manual pages available on the system.

Double-clicking | Dragging and

opens the dropping SN
'‘Manuals' an object has no

window effect.

containing

pushbuttons for kManuals
displaying

manual pages.

Please refer to section "Displaying manual pages" for information on how to operate the
window of the ‘Manuals' desktool and display the online manual pages for the
SINIX/windows User Environment.

You can use the software manager described in section "Displaying the calculator” to check
whether the manual pages are available on your system.

7.2.5 Administering user accounts

User Manager
provides you with an overview of local and global login
names and user groups on the system. If you are the system
administrator, you can manage the login names and user
groups. The user manager can also be started on remote
hosts.

Double-clicking | Dragging and

opens a window dropping

in which the an object has no

names of effect. User Manager
;)r/:tgir:pll'las; erz in kerstin@gqm2chat
the form of

icons.

The user manager allows you to display user accounts and user groups known to your host.
In addition, it lets system administrators manage them as objects.

If your host is managed by the Network Information Service NIS, you can also view global
user accounts and global user groups. System administrators of the NIS master server can
manage global user accounts and groups.

In a user manager window the objects "user account" and "group” are represented as icons.
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By default, such a window (a "user manager view") displays all users of the system.
However, it is possible to display only those users that belong to a certain group.

In System Administrator mode it is possible to manage user passwords or to create, modify,
and delete local user accounts or groups. Local users or groups may even be removed into
the trashcan, and later on be retrieved or permanently deleted from the system. The user
manager also manages the assignment of icon pictures to users and groups. If you are
working on a NIS master server you can also manage global user accounts and groups.

7.2.6 Viewing a file system accessable via NFS

NFS Manager
enables you to view file systems accessable via NFS. If you
are the system administrator, you can manage these file
systems. This enables you to mount and unmount remote
file systems, provide local access to them and delete those
to which access has been provided. The NFS manager can
also be started on remote hosts.

Double-clicking
opens a window
containing a list

Dragging and
dropping
an object has no

of all configured effect.
share and

mount points.

HFS Manager
kerstin@gm2chat

If NFS is running on your system, you can access file systems that arre exported from
remote hosts via NFS and that are locally mounted. Only the system administrator is
allowed to mount and unmount file systems.

In the lower part of the NFS manager's window you can view directories that are mounted
locally via NFS. You can use the file manager to access its files and directories in the
normal manner.

7.2.7 Viewing a file system stored on a CD-ROM

Volume Manager
enables you work with archives and file systems stored on
devices with removable media. The volume manager can
also be started on remote hosts.

Double-clicking Dragging and

opens a window dropping

containing a list an object has no

of all configured effect.

devices with Volume Manager
removable kerstin @ gma2chat

media, including
CD-ROM, floppy
disk and
streamer tape.

If a CD-ROM drive is attached to your system, you can access file systems stored on a
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7.2.8

7.2.9

CD-ROM. Only the system administrator is allowed to mount and unmount file systems.
Before a file system can be used, it must be mounted in the file tree. The system
administrator specifies the directory that is to be used as the mount point. Once the file
system has been mounted, you can use the file manager to access its files and directories
in the normal manner. An easy access to the root of the file system is provided by double
clicking the respective CD-ROM device in the volume manager's window. A file manager's
window will then be displayed allowing you to view the CD-ROM file system.

Managing software

Software Manager
displays information about the software that the system can
access. If you are the system manager, you can change the
status of the software: for example you can load, install and
delete software. You can also start the software manager on
remote hosts.

Double-clicking | Dragging and
opens a window dropping

which contains an object has no
the available effect. Y

H Q are anager
software in the thom@sis12raven

form of icons.

In its main window, the software manager displays the software which the system
recognizes. The window title consists of the elements <host_name>:<software_position>:
<current_software_object>. The icon format provides information on the status of the
software it represents:

the software is a software package or a software product consisting of several software

packages;

the software is located on the host or on an external volume;

the software is partially or completely installed in the system or it is not installed in the

system.
Depending on the status of the software object, the system administrator has a number of
different operations at his disposal. For example, he can select, load, install, transfer and
delete software or display and sort information about software. You can select the
operations from menus on the menu bar or from the pop-up menus of the individual icons. If
you do not have system administrator privileges, you will be prompted to enter the system
administrator password. If you do not know this password, you cannot make any changes to

the software status.

Displaying information on the system status

Information
displays information on the system, the disk capacity,
current processes as well as information on your screen.

Double-clicking Dragging and
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opens the
'Information’
window. You
determine the
information
displayed using
the window
menu bar.

dropping
an object has no
effect.

Information

The window displayed when you call the ‘Information’ desktool contains an empty display
area which you can fill with the desired information by selecting the appropriate item from
the 'Information' menu.

System Info

displays information on the system architecture, system
activity, as well as status messages.

Double-clicking

Dragging and

r

opens the dropping ) E '
'System Info' an object has no

window. You effect.

determine the System—Info
information

details displayed
using the "List'
buttons.

The window displayed when you call the 'System Info' desktool contains a display area
which you can replenish with additional information by clicking the appropriate ‘List' button.
This includes e.g. detailed information on errors, warnings, dumps, or the output of th

sar (1) command. Using the 'Number of hours back’ slider you can set the period for the
display of the system activity history.

7.2.10 Interrupting a session

Lock Screen/Screen Saver
interrupts your session until you enter your password.

Double-clicking Dragging and

locks the screen dropping
and activates a an object has no
screen saver. effect.

Lock & save
Screen

You can interrupt your session at any time by double-clicking on the 'Lock Screen' desktool
and thus prevent unauthorized users from accessing your screen. You will find a detailed
description of this desktool in section "Interrupting a session".

Screen Saver
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You can choose and configure a screen saver.

Double-clicking Dragging and

opens the dropping /
window Screen an object has no '
Saver. effect.

Screensaver

You can choose a special Screen Saver and determine the parameters of the automatic
screen lock.
Note:

These objects are not available if you are working in a session in the Common Desktop
Environment.
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7.3

7.3.1

7.3.2
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Creating, editing and mailing text files

This section provides you with information on creating and editing text files and sending mail

to other users.

Creating a file with the file manager

File Manager

enables you to work with files and directories displayed in
windows as icons. The file manager can also be started on

remote hosts.

Double-clicking
opens a dialog
box in which you
enter the name

Dragging and
dropping

an object has no
effect.

File Manager

of the directory kerstin@qm2chat

you want
displayed in a

window.

Double-click on the 'File Manager' icon and enter in the dialog box the name of the directory
you want displayed in the file manager window. You can also enter an environment
variable, e.g. suome for your home directory.

The contents of the directory are displayed in the file manager window as an icon. Create a
new file using the 'File' menu. Once you have entered the file name in the dialog box, a new
icon representing the newly created file is displayed in the window.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

Editing afile

Editor
enables you to edit different types of objects, for example
text files, image files or other desktools.

Double-clicking Dragging and
opens a window dropping
in which a text an editable object

file can be loads the object ;
created and into a suitable -
edited. editor. Editor

You now wish to edit the empty file created by the file manager. Drag and drop the file onto
the 'Editor' desktool.

You can select the text editor that is called by this action using the 'Preferences' desktool. In
the original configuration, the "Text Editor' window generated by the client mined is
displayed. Write a short message that you would like to send as mail in the text area. You,
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7.3.3

7.3.4

yourself, will be the recipient of this message.
The 'File' menu provides you with menu items for creating, opening and saving a file and for
exiting the text editor. Save your message and then close the window.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

Transferring a file to the communication manager

Communication Manager
enables you to read, store and send electronic mail. The
communication manager can also be started on remote
hosts.

Double-clicking Dragging and
opens a window dropping LE
in which your an object has no Communications Manager
mail is displayed | effect. Uest@chertscy

in the form of
icons.

When you call the communication manager, the mail you have received is displayed in a
window. If you wish to send mail, select the appropriate item from the 'File' menu. A new
window is displayed, which, among other things, contains an editor in which you can enter
and edit the message.

A file can be dropped onto the MIME-editor of the 'Send' dialogbox. By doing this you
indicate that the contents of the specified file are to be sent as mail.

After clicking the action button 'OK' the mail is sent. The communication manager informs
you about the mail you have received. Incoming mail is shown as icons in the window.

Removing objects

Trash
enables you to remove objects such as files, mail and login
names from the object manager windows. These objects
can be restored provided that the trashcan has not yet been
emptied thus deleting its contents. Desktools that you create
yourself and toolboxes cannot be restored.

Double-clicking Dragging and

opens a window dropping

in which the an object removes

trash belonging it from the object

to the file manager's window

manager is and places it in the Trash
displayed. trashcan.

You can trash objects from object manager windows (e.g. users, hosts, mail).
Drag your file from the file manager window and drop it onto the "Trash' desktool. Do the
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same if you want to throw away mail. Then display information on the object by selecting the
appropriate items from the pop-up menu of the 'Trash' desktool.

You can now use the drag-and-drop mechanism to move objects from the trashcan back to
the window of the associated object manager. You can also delete the object (and, at the
same time, all the trash belonging to the object manager) irretrievably by emptying the trash
using the pop-up menu of the Trash' desktool.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.
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7.4 Creating and editing an audio file
Audio player
allows you to play, edit, and record audio files.
Double-clicking Dragging and
opens a window dropping J_
in which an an object has no s
audio file can be effect. e
created and Audio Player
edited.

The audio manager provides a simple tool to play, edit, and record audio files. While the
playing and recording capabilities remind one of a cassette recorder, the editing functions
have the look and feel of a normal text editor.

The interface consists of a menubar, an input controller, a selection controller, a graphic
display of the audio data, an input and output volume scale as well as cassette recorder
buttons to control the recording, playing and positioning of the file.

The audio manager connects to an audio server which performs the actual recording and
playing of the data. This server may run locally or reside on a remote machine and acts
much like the X server.

Since sound data is converted to an internal format, the user can load, save, insert, edit,
and mix files together without worrying about the various sound file fomats available. File
format and data conversion are also made simple using the audio manager. Audio file
formats which are supported by Xmaudio include:

- Microsoft WAVE

- Sun NeXT

- Creative Labs VOC

- AIFF

- Amiga IFF/8SVX
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7.5

7.5.1

7.5.2

Creating and editing an image file

This section provides you with information on how to create and edit an image file and make
it available as an icon image.

Creating an image

Hardcopy
enables you to generate and store hardcopy dumps of the
graphical user interface, convert them to a different file
format, and display and print them.

Double-clicking Dragging and

opens the dropping
'‘Hardcopy" an object has no
window. effect.

Hardcopy

You will now create a hardcopy dump of a selected area of your screen that you can use
later as an icon image. Therefore the image you create should not be too big. You can, for
example, use the minimize button of a window as your image.

Start the 'Hardcopy' desktool and select 'Capture’ from the 'Image’ menu. The shape of the
pointer changes and you use this new pointer to indicate the part of the screen you wish to
generate as a dump. Point to the upper left-hand corner of the desired area and press
<BSelect>, move the pointer to the lower right-hand corner and release the mouse button.
A message indicating that an image has been captured is displayed in the 'Hardcopy'
window. Store the image file using the 'Image' menu.

Editing an image and creating an icon image

Pixmap Editor
enables you to create and edit bitmap or pixmap files.

Double-clicking Dragging and
opens the dropping

'‘Pixmap Editor' an image file starts
window in which the pixmap editor

a new image file with this file. - -
can be created. Pixmap Editor

Drag your image file from the file manager window and drop it onto the '‘Pixmap Editor’
desktool. You can now use the pixmap editor to edit the image you captured. You can, for
example, draw lines or circles, change the colors or copy and move areas of the image. The
command area of the pixmap editor contains a number of radio buttons that you can use to
quickly select the desired editing function. You will use the fact that it is possible to copy
parts of your image to different windows belonging to the pixmap editor when you create an
icon image. In order to be able to select a section of your image, click with the mouse button
<BSelect> on the radio button represented as an image of a pointer. First mark the
rectangular area of your image that you wish to use as the icon image with the mouse
button <BSelect>. Use the 'Edit' menu to copy this area to the cut buffer.

The pop-up menu of the 'Pixmap Editor' desktool contains items for creating new icon
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7.5.3

images. Create a color icon with a height and width of 64 x 64 pixels. The pixmap editor is
started with an empty image of this size. Using the 'Edit’ menu, paste the section of your
image stored in the cut buffer in the empty icon image. You can position the outline of the
image within the frame of the icon image by pressing and holding down the mouse button
<BSelect>. In order for the 'Image Browser' desktool to display the icon image, you must
store the file under a file name with an extension indicating the size of the icon image (in our
example: .64). Use the file manager to display the contents of the directory in which you
have stored the icon image.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

Using an image file as an icon image

Image Browser
displays icon images that are available system-wide and
icon images that you have created yourself.

Double-clicking Dragging and
opens a window dropping

in which your an object has no =
icon images are | effect. Image Browser
displayed.

Once you have started the 'Image Browser' desktool by double-clicking on its icon with the
mouse button <BSelect>, your icon images are displayed. Each window of the desktool
contains two images with the labels '<<' and '>>' which you can use to navigate the
directories in which the available icon images are stored.

Drag the file containing your icon image from the file manager window and drop it onto the
window containing your icon images. This window subsequently contains the icon image
you created.

You can now use your icon image for representing objects on the desktop by exchanging it
for the icon image of a desktool, for example. To do this you drag and drop the desired
desktool onto the 'Editor'. A window in which you can edit the desktool is displayed. Drop
your icon image onto the area of the window that contains the image of the desktool. Once
you confirm the modification, the icon image you created is used to represent the desktool
on the desktop.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.
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7.6

7.6.1

7.6.2

7.6.3

Processing files

This section explains how to print or compress a file and how to save a file on floppy disk or
streamer tape. You process the text or image file created in the previous section, or you can
process a number of files simultaneously by selecting them (section "Selecting and
deselecting icons") and then dragging and dropping them onto the appropriate desktool
(section "Selecting and deselecting icons").

Printing a file

Printer
enables you, among other things, to print files, modify print
jobs, and query printer and job status. The desktool can also
be started on remote hosts.

Double-clicking | Dragging and

opens a window dropping

in which the an object starts the Sr—-—
status of print predefined print ;

jobs is method for the kerstin@qm2chat
displayed. object.

You print a file by dragging the file from the file manager window and dropping it onto the

'Printer' desktool.

You can use the 'Hardcopy' desktool to print an image file. It allows you to convert files into
various formats and set options for the print job. You can, for example, generate a
PostScript file from a pixmap file in GIF format (Graphics Interchange Format) and print it

with a height and width of your choice.

Compressing a file

File Compressor
enables you to compress files in order to save space. You
can decompress compressed files, which are indicated by a
special icon image.

Double-clicking Dragging and
opens a help dropping
window a file compresses
containing help or decompresses
on the desktool. the file, depending
on its state.
Compressor

Drop a file onto the 'File Compressor' desktool. The fact that the icon image has changed
indicates that the file has been compressed. Decompress the file by dropping it onto the
'File Compressor' desktool again.

Saving afile on floppy disk or streamer tape

The 'Volume Manger' desktool is a tool that you can use to back up and read in files (see
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section "Viewing a file system stored on a CD-ROM"). Before you call this tool, place a
floppy disk or streamer tape, as appropriate, in the drive.

You back up a file by first starting the desktool. Then you drop the file onto the device
containing the inserted removable media. The file is preselected in the open selection
window. Start the write operation by clicking on the 'Apply’ pushbutton. The write operation
is logged in the same window.
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7.7

7.7.1

7.7.2

Configuring the working environment for the local host

You work on your desktop with applications that you can start both on your local host and
on remote hosts. The local host is the system you log in to for your session. For example,
you can use the user manager to set up a new user who can work only on the local host or
who has global privileges, i.e. receives a work area on remote hosts in the network as well.
In this section you will find an explanation of how to modify behavior for mouse actions,
define fonts for window controls, change the date and time as well as its format and save
your desktop configuration when you terminate your session.

Setting the time interval for double clicks

Mouse
enables you to change the behavior of the mouse. You can,
for example, change the button bindings for left-handed

users.
Double-clicking Dragging and
opens the dropping
'‘Mouse an object has no
Configuration’ effect.

window.

Double-clicking with a mouse button means clicking the button twice in rapid succession.
You can specify the time interval that distinguishes between slow and fast clicks using the
'‘Mouse' desktool.

You use a scale in the 'Mouse Configuration' window to set the time interval. The value you
set is the length of the interval in tenths of seconds.

Confirm the new value you have specified for the time interval between two clicks with the
'Ok’ or 'Apply’ pushbutton. A dialog box is displayed if the settings cannot be applied by the
desktool immediately.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

Activating a window by moving the pointer

Window Manager
enables you to modify window manager attributes. You can,
for example, specify whether an icon box is to be created.

Double-clicking | Dragging and

opens the dropping

'‘Window an object has no

Manager effect. |Window Manager|
Configuration’

window.
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You can use this desktool to define the mouse action that activates a window, among other
things. Only the active window can receive keyboard input. You can specify whether you
must click on a window explicitly or whether it is sufficient to move the pointer onto the
window. You activate a window in the original configuration by clicking on it.

Once you have called the 'Window Manager' desktool, you define the desired behavior by
setting the corresponding radio button.

If you wish to change the behavior of the window manager, confirm your setting. A dialog
box informs you that the modifications made will not take effect until the window manager
has been restarted.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

7.7.3 Changing the fonts in windows

Color & Font
allows you to change the colors and fonts in windows.

Double-clicking | Dragging and
opens the 'Color | dropping

& Font' window. an object has no
effect. T
Color & Font

You use this desktool to change the appearance of a window on your screen. You change
the fonts in a window by selecting a different font family, in which a number of fonts for
different areas of the window are grouped together.

A configuration that has been modified with this desktool does not affect the current state of
the desktop. Therefore, the 'Color & Font' window includes a display area in which the effect
of your current selection is demonstrated. This allows you to see which parts of the window
are affected by your selection.

Compare the listed font families by clicking on the items in the list. You confirm your
selection using the pushbuttons at the bottom of the window.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

7.7.4 Setting the date and time

Date & Time
enables you to display the date, time and time zone settings
on the local host. If you are the system administrator, you
can also change the settings.

Double-clicking Dragging and
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Opens the 'Date dropping
& Time' window. an object has no
effect.

Date & Time

This desktool enables you to display the date, time and time zone settings used, for
example, when you display the 'Clock’ desktool on your system. The position of the button
beneath the list box tells you whether the selected setting takes daylight savings time into
account.

You must have system administrator privileges to change these settings. Otherwise you will
be prompted to enter a password when you try to access the desktool. You cannot make
any changes unless you know the password.

7.7.5 Configuring a country-specific user environment

National
enables you to customize the country-specific aspects of
your user environment. For example, you can select the
language and customize the display of information such as
the date, time and currency to suit your individual needs.

Double-clicking | Dragging and EE
opens the dropping % ﬁll
‘National' an object has no J

window. effect. P11 .

Mational
Environment

You can use this desktool to change the environment variables of your user interface.

First, you must determine whether you want the changes to apply only to a specific user or
to the entire system. To make system-wide changes, you must have system administrator
privileges. Otherwise the system will prompt you to enter a password; you cannot make any
system-wide changes unless you know this password.

Click on the ‘Language’ pushbutton to display the available language variants. After
selecting a language variant, you can make all additional formats dependant on this general
language setting. If you do not want to do this, you can manipulate the individual formats
manually.

The individual settings include sorting order, currency format, date and time format,
character class and numerical format. The various menus corresponding to the option
buttons list the possible language variants.

For more details, refer to the help texts and the section entitled "National Environment - NLS
(Native Language System)” in the SINIX Commands Reference Manual, Volume 1.

7.7.6 Auto-starting an application at the beginning of a session

Auto-Start
enables you to start selected applications automatically at
the beginning of each session. For example, you can
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7.7.7

automatically display a clock when you start working with the
desktop.

Double-clicking Dragging and

opens the dropping

'‘Auto-Start' an object starts the

toolbox corresponding
application at the '
beginning of each IAutﬂ—Start
subsequent )
session.

The section "The 'Auto-Start' toolbox" contains a detailed description of how to copy the
desktools to the special 'Auto-Start' toolbox and then execute these applications
automatically from the desktop at the beginning of each subsequent session.

Note:

This object is not available if you are working in a session in the Common Desktop
Environment.

Saving the current desktop configuration upon termination

Preferences
enables you to change certain attributes of the desktop. You
can, for example, specify the size of the icons or change the
drag attributes.

Double-clicking Dragging and
opens the dropping

'Preferences’ an object has no
window. effect. | Preferences I

In the original configuration, you are asked whether you wish to save the current desktop
configuration before you terminate your session. You can use the 'Preferences’ desktool to
either suppress this query or to specify that the desktop is to always be saved or never be
saved at the end of a session. Your selection also applies to all other object managers.

In the 'Preferences' window you can select and confirm one of the values offered on the
options menu.
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7.8
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Configuring your working environment for remote hosts

When you configure a remote host, a distinction is made between users and system

administrators.

All users can configure their own working environment for remote hosts by starting the

appropriate desktools on the remote host involved. The system administrator can use the
desktools provided for managing users, hosts, X terminals and font services to modify the
existing configuration and thus the working environment for users on the local and remote

hosts.

Host Manager
provides you with an overview of hosts and host networks
as well as information on such topics as availability, network
integration and the system type used. To perform
administrative tasks, you require system administrator
privileges. The host manager can also be started on remote
hosts.

Double-clicking Dragging and
opens a window dropping

in which the an object has no
hosts are effect.

displayed in the

Host Manager
kerstin@gm2chat

form of icons.

X Terminal Administration
provides you with access to X terminal administration. You
start the desktool via the menu items on the pop-up menu.
To perform administrative tasks, you need system
administrator privileges.

Double-clicking Dragging and

opens a help dropping
window an object has no
containing help effect.

on the desktool. * Terminal
Administration

Font Service
provides you with access facilities for administering,
installing and making available fonts for one or more hosts.
To perform administrative tasks, you need system
administrator privileges.

Double-clicking Dragging and
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7.8.1

7.8.2

opens the font dropping
server an object has no
administration effect.

window.

|Font Service

Several desktools provide you with a convenient means of working on remote hosts. You
can recogize these desktools on the desktop by the fact the icon label is made up of the
login name and the host name of the system for which they have been configured. Provided
you have not made any changes, all the desktools are configured for your login name on
the local host.

This section provides you with information on granting access to a remote host, configuring
the 'File Manager' and 'Printer’ desktools for this host and printing files located on the local
host on a remote printer.

Note:

If you want to work with desktools located on remote hosts,
SINIX/windows User Environment V2.0 or a later version must be installed on the

remote host,
a user account must be set up for you on the remote host. The login name does not
have to be identical to your login name on the local system.

Granting access to remote hosts via terminal emulators

Emulator
enables you to work with the operating system via a
terminal emulator. This desktool can also be started on
remote hosts.

Double-clicking | Dragging and
opens the 'Shell' dropping
window. an object has no
effect.

Emulator
kerstin@gm2chat

If you wish to start an application program located on a remote host from your local system,
you must make your local login name known on the remote host. This information must be
stored in a special file on the remote host.

Call the 'Emulator’ desktool. Log in to the remote host. Create a .rhosts file in the home
directory of this login name and enter a line with the following syntax in this file:

localHost localLoginName

Save the file. You can now start applications located on the remote host from your local
host.

Managing files and directories on remote hosts

You are now going to configure and call a file manager for a remote host. You can use the
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7.8.3

host manager to obtain an overview of the remote hosts known to your local host.

Open the desktools catalog and drag the file manager icon onto the desktop. The pop-up
menu of this desktool contains items relating to configuration.

Select 'Define host..." from the pop-up menu. Enter the name of the remote host in the
dialog box that is subsequently displayed. You can enter the name at the keyboard or with
the help of the host manager, dragging the icon representing the remote host from the host
manager's window and dropping it onto the text box. Once you have confirmed your input,
the dialog box is closed. The file manager's icon label now contains the name of the remote
host.

Now assign the file manager the name of the user, i.e. your login name, on the remote host
in the same way.

Then select 'Authorize' from the pop-up menu. This gives the remote file manager
permission to open a window on your screen and accept input from the mouse and
keyboard. A dialog box informs you whether authorization was successful or not.

Note:

For reasons of security, authorization is only valid until the end of your current session.
When you log in to the system again, you must authorize desktools configured for
remote hosts again.

Now start the remote file manager. The remote file manager then displays the contents of
the directory you select.

Accessing a remote printer

You are now going to configure the 'Printer’ desktool for a remote host on your desktop.
This enables you to print files located on your local system on the remote printer.

Open the desktools catalog and drag the printer icon onto the desktop. Assign the 'Printer’
desktool the name of the remote host and your login name on that host. Then authorize the
remote 'Printer".

You can now drag a file from the window of the local file manager and drop it onto the
remote 'Printer'. This initiates the printing of this file on the remote printer. Dragging and
dropping also enables you to print a file located on the remote host on the local 'Printer'.
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7.9

7.9.1

7.9.2

Saving the current configuration

You can save the current configuration of the desktop and the configuration of the windows
of other object managers. You can at any time save the configuration of an individual object
manager. It is also possible for you to specify whether the current configuration of all object
managers is to be saved at the end of a session.

Saving the current configuration immediately

Select 'Save' from the 'File' menu.
A message box is displayed. As soon as you confirm the information displayed in the
message box, the current configuration is saved.

Saving upon exit

You can use the 'Preferences’ desktool to specify whether the current configuration is
always saved at the end of a session, is never saved or is only saved when you specify so
explicitly.
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7.10 Shutting down the local host

Shutdown
enables the system administrator to shut down and restart
the local host.

Double-clicking | Dragging and

opens the dropping =5 I
'Shutdown' an opject has no H E
window. effect. x

Shutdown

If you do not have system administrator privileges, the system will prompt you to enter the
system administrator password in the 'Shutdown' window. You cannot shut down or restart
the host unless you know this password.

Furthermore, you can use a pop-up menu to define the status and display a grace-period
scale which shows the amount of time remaining between pressing the 'Start' pushbutton

and the beginning of system shutdown. You can close any applications that are still running
during this period.
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8 Related publications

SINIX/windows
Documentation Overview

SINIX/windows User Environment
Guide for Experts and System Administrators
(SINIX Desktop)

SINIX/windows User Environment
Clients Reference Manual
(SINIX Desktop)

SINIX/windows User Environment
XDCL Desktop Configuration Language
(SINIX Desktop)

Reference Manual

SINIX/windows User Environment
Desktop Kornshell User's Guide
(Common Desktop Environment)

SINIX/windows User Environment
User's Guide
(Common Desktop Environment)

SINIX/windows User Environment
TED Enhancements
(Common Desktop Environment)

SINIX/windows User Environment
Advanced User and System Administrator Guide
(Common Desktop Environment)

SINIX/windows Development
Product Overview

SINIX/windows Development
OSF/Motif
Style Guide Release 1.2

SINIX/windows Development
OSF/Motif
Programmer's Reference, Release 1.2

SINIX/windows Development
OSF/Motif
Programmer's Guide, Release 1.2

SINIX/windows Development
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OSF/Motif
X Server Reference Manual

SINIX/windows Development
X Window System, Xt Toolkit Intrinsics
Reference Manual

SINIX/windows Development
X Window System X11, Xlib
Programming Manual

SINIX/windows Development
X Window System, Xlib
Reference Manual

SINIX/windows Development
X Window System X11 Rel.5 (SINIX), X Input Extension
Programmer's Reference

SINIX/windows Development
X Window System, X Protocol
Reference Manual

SINIX/windows Development
Widget Set
Programmer's Reference

SINIX/windows Development
Programmer's Guide
(Common Desktop Environment)

SINIX/windows Development
Programmer's Overview
(Common Desktop Environment)

SINIX/windows Development
Application Builder User's Guide
(Common Desktop Environment)

SINIX/windows Development
Help System Author's and Programmer's Guide
(Common Desktop Environment)

SINIX/windows Development
Internationalization Programmer's Guide
(Common Desktop Environment)

SINIX/windows Development
Style Guide and Certification Checklist
(Common Desktop Environment)
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SINIX/windows Development
Tooltalk Messaging Overview
(Common Desktop Environment)

SINIX/windows Development
Tooltalk Programmer's Guide
(Common Desktop Environment)

Ordering manuals

The manuals listed above and the corresponding order numbers can be found in the
Siemens Nixdorf List of Publications. New publications are described in the Druckschriften
Neuerscheinungen (New Publications).

You can arrange to have both of these sent to you regularly by having your name placed on
the appropriate mailing list. Please apply to your local office, where you can also order the
manuals.
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Glossary

A accelerator

A key sequence with which you can quickly access interface elements. If, for example, an
accelerator has been defined for a menu item, you can activate that item by pressing the
key sequence, without having to display the menu. The accelerators are displayed next to
the menu item.

active window

The window which currently has input focus. Only an active window can receive input from
the keyboard. Only one window may be active at a time.An active window is distinguished
from non-active windows by the color of its window frame and by a change in the shape of
the text or selection cursor. You make a window active by either clicking on one of its
components or by moving the pointer onto the window, depending on the configuration.

B bitmap

A bitmap is a pixmap with a depth of 1. Bitmaps can, for example, be used for icons, the
pointer, background or foreground patterns.

C cascade menu

A menu item that provides access to a submenu. The submenu is displayed next to the
corresponding menu item.

check button

A button that can have two states. It represents one of a group of options, any number of
which may be selected.

click
Pressing and releasing the mouse button once.

client

An application that exchanges data with the X server. The client and the X server can be
running on different computers.A client sets up a connection to the X server and prompts
the X server to perform a certain task, for example, display a window. The X server directs
user input to the client, for example, the fact that the user has clicked on a pushbutton in the
client's work area. Some clients do not require a window, for example if they only set
attributes of the X server and do not expect any input or output on the screen.

D deselect
Cancel a selection, for example, of items in a list box or of icons.

desktool

A desktool is an application that can be called via its icon on the desktop. Desktool icons
are provided by the desktop manager.

dialog box
A window requesting, or giving, information, or requiring you to select from a number of
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possible choices.

directory window

The work area of a directory window is used to display the contents of a directory in the
form of icons.

display

The graphical input/output device. A display consists of one or more screens, a keyboard
and a pointing device, e.g. a mouse. An X server controls exactly one display. The X server,
for example, interprets a client's request to display a window or pass input from the mouse
or keyboard to the client. Several clients can output to one and the same display
simultaneously, allowing the user to work with several applications in parallel.

double-click

Pressing and releasing a mouse button twice in rapid succession. An action can be defined
for a control, e.g. a pushbutton or icon, that is invoked when a double-click is performed.

drag

Pressing and holding down a mouse button and then moving the mouse in order to move an
object on the interface, change the size of a window or move the pointer through the items
on an open menu.

drag and drop

Pressing the mouse button <BTransfer> while pointing to an object, moving the object to a
new position and then releasing the mouse button. The action invoked by this operation
depends on the object which is dropped and the place it is dropped on.

F font
A font groups together alphanumeric characters, special characters or graphics elements
(e.g. for the pointer) under a single name, the font name. Fonts are supplied by the X
server.

G graphical user interface
Makes its possible to interact with a computer by means of images. Graphical applications
use elements taken from everyday life, which are therefore easily understood by the user.
Communication with the computer takes place primarily by manipulating graphical objects.
The input of commands via the keyboard is secondary.

gray out

Graying out is a technique used to indicate that something cannot be used in the present
context.In the standard configuration, the components of a window that cannot currently be
accessed are grayed out. These could be, for example, menu items that initiate an action
that would make no sense in the current context.

H help system

The help system provides access to action- and task-oriented information that can be
displayed on the screen. The help system provides its own windows in which the
information can be accessed as help texts.
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I icon

A small graphical representation of an object that can be used to access the functionality of
that object. An icon comprises an icon image and an icon label. Icons that are managed by
the window manager represent active applications. Object manager icons represent the
associated objects, for example desktools or files and directories.An icon can provide a
pop-up menu that is opened when the mouse button <BMenu> is pressed with the pointer
positioned on the icon.

icon box

The icon box is a window in which the window manager displays the icons of the clients
started for the display. Minimized windows are displayed in the icon box in 3-D, opened
window are displayed two-dimensionally.

input focus

The input focus determines which window receives input from the keyboard. An active
window has the input focus.

M manual page

Manual pages ('man' pages) are a collection of files which contain the reference sections of
the documentation of a product and which can be displayed on the screen.

maximize

To expand a window until it fills the entire screen. Some windows can only be expanded to
a certain size.

maximize button

The button in the right corner of the title bar of a window. When you press the maximize
button, the window is expanded to fill the entire screen. If you press the maximize button in
a window that has already been maximized, it returns to its original size.

menu

A rectangular area containing a list of menu items. Selecting an item from a menu invokes
the action defined for the menu item.

menu bar

A rectangular area below the title bar of a window. The menu bar contains the names of the
pull-down menus provided by the client for this window.

message box

A dialog box that contains a warning or an error message.
minimize

Reduce a window to an icon.

minimize button

The button in the upper right corner of the title bar, next to the maximize button. When you
press the minimize button, the window is reduced to an icon.
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mnemonic

The mnemonic of a menu item is a single letter of the alphabet that appears in the menu
item. It identifies this menu item uniquely within the whole menu. The mnemonic for a menu
item is underlined. You can use the mnemonic to select a menu item from an open menu.

mouse

A pointing device which you can use to move the pointer freely around the screen. In
SINIX/windows, you may use either a two-button or three-button mouse.

mouse button

A key on a mouse. There are physical and virtual mouse buttons. Physical mouse buttons
designate the actual arrangement of the buttons on the mouse, e.g. left mouse button or
mouse button 1; virtual mouse buttons designate the function that they perform, e.g. the
mouse button <BSelect> is used to select icons. The bindings between physical and virtual
mouse buttons can be freely configured, e.g. they can be changed for left-handed users.

mouse cursor
See "pointer".

O object

An element which the user can see and manipulate on the graphical user interface, e.g.
files, desktools or text. As a rule, objects are represented as icons that the user can operate
with the mouse.

object manager

A client that makes objects available in a window. An object manager can manage different
types of objects, e.g. files and directories. The desktop manager, file manager and mail
manager are examples of object managers.

P pixmap
A pixmap is a definition of color values that can be interpreted as a two-dimensional
arrangement of pixels. A pixel is the smallest element of a screen that can be defined. Each
pixel in a pixmap has the same number of bits, e.g. n bits. The pixmap is then said to have a
depth of n. The greater the number of bits provided for defining the pixmap, the greater the
number of colors that can be represented. Pixmaps can be used for icons and for
background or foreground patterns, for example.

point
Position the pointer at a particular point in a window.

pointer

The graphical symbol representing the mouse on the screen. The pointer tracks the
movement of the mouse on the screen. The mouse can change shape depending on its
position and the context in which it is displayed. Also known as a mouse cursor.

pointing device
A device such as a mouse or graphics tablet that can be used to move the mouse freely
around the screen.
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pop-up menu
A menu that is associated with a control and which cannot be accessed via the menu bar or
menu name. It is displayed whenever a certain action is performed on the object for which it
has been defined. The root window menu is an example of a pop-up menu; it pops up when
the mouse button <BMenu> is pressed in the root window.

press
Pressing and holding down a mouse button.

primary window
A window that is generated when a client is called. All other windows opened from a primary
window are known as secondary windows.

pull-down menu

A menu whose menu items are not displayed until the menu name is pressed in the menu
bar.

pushbutton

A rectangular area within a window, delimited by a 3-D shadow, with which an action can be
initiated when the pushbutton is pressed. A pushbutton has a label consisting of an image
or text describing the action.

R radio button
A button that has two states. It represents one of a group of mutually exclusive options.

resource

You use resources to customize your user interface. You can use resources to influence the
appearance, size, position, color and pattern of windows, 3-D shadows, window fonts and
input processing.

root window

The window that provides the background on a screen and upon which all other windows
are arranged. The root window is generated by the X server. It is not managed by the
window manager and therefore does not have a window frame.

S scroll bar

A bar which lets you move through the contents of a window or list, for example, horizontally
or vertically. The functional parts of the scroll bar are the slider and the arrow buttons. The
area that can be made visible with the aid of a scroll bar depends on the size of the buffer.

secondary window
A window that is opened from a primary window.

select

Choosing one or more objects for processing. The selected objects are marked in some
way, e.g. their labels are displayed in reverse video.

selection cursor
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A graphical symbol indicating the position at which an object can be selected or deselected
using the keyboard.

selection dialog box
A dialog box containing a list of items you can select, such as a list of file names, a list of
printers available in the network or a list of font or color names.

shell access
Permission to work at SINIX command level.

stacking order

The order in which the windows on the screen are arranged. The uppermost window is
visible in its entirety. It obscures the other windows partially or totally. You can change the
stacking order by moving a window to the bottom or top of the stack.

T text cursor

A graphical symbol indicating the position at which text can be entered. The text cursor may
change shape, depending on its position and the context in which it is displayed.

text box
An area in a dialog box for entering text.

title bar

The rectangular area at the top of a window that contains the window menu button, the title
area (in which the name of the window is displayed) and the minimize and maximize
buttons. The title bar can be used to move the window.

toolbox

An area on the desktop where the desktop manager makes desktools available. Toolboxes
can also contain other toolboxes.

W window

A window is a rectangular area on a screen that the window manager, mwm, surrounds with
a frame. Each window has its own input and output functionality.

window manager

The window manager, mwm, is a client that manages the primary and secondary windows
of a display. It makes it possible to resize or reposition a window, minimize or maximize a
window, change the stacking order and perform other similar operations. The window
manager does not, however, have any influence on the work area of a client. The work area
of a client is managed exclusively by the client itself.

window menu

A pull-down menu containing the menu items for managing a window, e.g. for moving it,
minimizing or maximizing it or closing it. The window menu is displayed when you press the
window menu button.

window menu button
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The button in the upper left corner of the window. The window menu is displayed when you
press the window menu button.

work area

The area of a window managed by the client that generated the window. The work area can
comprise a number of controls. The window frame does not belong to the work area and is
managed by the window manager.

X X server

An X server is a program that controls a display and all the connections between the display
and clients. Because the X server controls only one display, the term "display" is often used
as a synonym for the X server. The X server provides the window mechanism, directs
graphics request from clients to the correct window on the correct screen and passes user
input to the client managing the currently active window. The X server functions only in
response to client requests.
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